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1 Introduction

11 About this Document

This document provides information on how to combine the following SAP for Insurance components to an
integrated insurance solution for product and policy lifecycle management:

* SAP Quotation and Underwriting for Insurance (FS-PRO) for product definition

* SAP Quotation and Underwriting for Insurance (FS-QUO) for writing new business

* Policy Management in SAP S/4HANA (FS-PM) for handling subsequent policy processing

* SAP Business Partner for Financial Services (SAP GP-FS) for providing and storing business partner data
The focus of this document is the creation of the integration solution. It doesn't cover the day-to-day activities

and usage of FS-PRO, FS-QUO, and FS-PM. For more information about features and usage, see the references
in Available Documentation [page 7].

The following graphic outlines all of the components with their relevant interfaces and msg.PM as the rating
engine:

FS-QUO FS-PM
¢ . 3
| PLIB interface Enumeration
values
s I 1 i 1 i per/
— 5 [ =
MNew e g_ APIF/New
Business = Business RGeS EHEIEE (et bz IFBC templates
bind 3
| POJO Adapter | | Run-time Adapter |
FS-PRO Run Time 1
Msg.PM
$ |
4 & Generate QAR from Designer
FS-PRO [
CesEis 3 - Product Definition PET/IFBC
import
2 Import of PBT and IFBC
configuration into FS-PRO

Explanation of diagram:

Define products in msg.PM Designer, and publish to FS-PM's IFBC.
Import PBT and IFBC product definitions to FS-PRO's Product Modeler.
Publish products to FS-QUO.

Generate msg.PM runtime product rules file (QAR) in msg.PM Designer.
Create quotes in FS-QUO.

After issuing, manage policies in FS-PM.

oA wN e
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Related Information

Available Documentation [page 7]

1.2 Audience

The document is aimed at system administrators or technical consultants to help them set up the relevant
connections between the different components. Furthermore, it provides a guideline for product developers
and business analysts on what needs to be considered when defining and publishing an insurance product in
FS-PRO that is designed to be consumed by FS-QUO and FS-PM.

It is assumed that you already have a working knowledge of the FS-PRO, FS-QUO and FS-PM applications.

1.3 Software Prerequisites

To use the features described in this document, you will need to ensure that the following releases of the
applicable software are installed:

* SAP Quotation and Underwriting for Insurance (FS-QUO) 1.1
¢ SAP Workplaces for Insurance (FS-IPW) 3.1

* Policy Management as part of SAP S/4HANA (FS-PM) 1909
¢ SAP Business Partner for Financial Services (SAP GP-FS)

1.4 Terminology

Mapping of FS-PRO and FS-PM Terms

In some cases, different terms are used in FS-PRO and FS-PM to describe the same concept.

These terms are listed in the following table:

Term in FS-PRO Term in FS-PM

IFBC Column Characteristic (IFBC)

Integration Guide for Coverage-based Insurance Solutions
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Term in FS-PRO Term in FS-PM

IFBC Control Attribute Attribute (IFBC)

Abbreviations

In the following table, the most important abbreviations used in this integration guide are listed:

Title Abbreviation
In-Force Business Configurator IFBC
Application Interface APIF/INPI
Policy-Based Technology PBT

Custom Business Object (ABAP term) CBO

1.5 Available Documentation

Additional documentation is available from the SAP Help Portal:

* Quotation and Underwriting for Insurance
* SAP S/4 HANA Insurance for Policy Management

* Business Partner

1.6 Post-Installation Setup Checklist

This topic describes the post-installation steps that must be performed to complete the setup of an integrated

environment with FS-PM, FS-PRO, and FS-QUO.

After you complete these procedures, you can define a product in FS-PRO or test the Sample Household

Product.

-> Remember

The standalone FS-PM, FS-PRO, and FS-QUO components must be successfully installed following the

instructions in their respective Installation Guides.

Integration Guide for Coverage-based Insurance Solutions
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Post-Installation Procedure

Role

Notes

Set up a connection for FS-
PRO and FS-PM for product
replication.

Technical Consultant or
equivalent role

Set up the connection be-
tween FS-PRO and FS-PM for
IFBC.

Technical Consultant, Sys-

tem Administrator, or equiva-

lent role

Set up the connection be-
tween FS-PM and FS-PRO
Runtime.

Technical Consultant, Sys-

tem Administrator, or equiva-

lent role

Set up the connection be-
tween FS-QUO and FS-PM.

Technical Consultant, Sys-

tem Administrator, or equiva-

lent role

This procedure is required
only if you are integrating
FS-QUO with FS-PM and FS-
PRO.

Set up the connection be-
tween FS-QUO and SAP GP-
FS.

Technical Consultant, Sys-

tem Administrator, or equiva-

lent role

This procedure is required
only if you are integrating
FS-QUO with FS-PM and FS-
PRO.

Set up Product Web Services
and test rating.

Technical Consultant, Sys-

tem Administrator, or equiva-

lent role

This procedure is required
for any product that you de-
fine in FS-PRO. Complete
this procedure before you
test the Sample Household
Product.

Configure Customizing set-
tings for IFBC import in FS-
PM.

Technical Consultant or
equivalent role

Do this procedure if you pub-
lish an existing product (such
as the Sample Household
Product) as part of the in-
stallation setup.

Later, when you define and
publish your own products in
FS-PRO, perform this step as
needed.

Related Information

Configuration Changes Needed for IFBC Push [page 16]

Setting Up Product Replication from FS-PM [page 43]

IFBC Import of FS-PRO Product Data [page 56]

Defining Product Module Groups for Runtime Adapter [page 29]

Integration Guide for Coverage-based Insurance Solutions
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2 Creating the Users Needed for the
Integration

2.1 Creating a User in FS-PM for RFC Calls and Granting
Authorizations

You need to create a user with two required authorizations in FS-PM for the RFC call .

Prerequisites

The user must have the authorizations for the following activities:
¢ Temporary storage of product deliveries in import buffer triggered by sending the IFBC structure from
FS-PRO to FS-PM.
¢ Execution of the IFBC import, including permission for writing transport entries and creating log entries.

Procedure

1. Call up transaction SUOL.

2. Create the appropriate user.

® Note

In the following documentation, only those settings are described that are relevant for the integration
of FS-PRO and FS-PM.

3. Onthe Logon Data tab, enter Syst emin User Type field (the user should be a system user, not a dialog
user).

In all other fields, you can enter the values according to your requirements.

On the Roles tab, create a new role and grant the relevant authorizations (see the subsequent steps).
Double-click the relevant Role field.

Choose the Authorizations tab.

In the Maintain Authorization Data and Generate Profiles section, choose Change Authorization Data.

© N o o »

Create the authorizations as described in the following table:

Integration Guide for Coverage-based Insurance Solutions
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Authorization Object Field Assigned Values

S_RFC (Authorization Check for RFC ~ ACTVT (Activity) 16 (Execute)
Access)

RFC_NAME (Name (Allowlist) of RFC ~ /PMO/ABC_IBC_RECEIVE_GNRL
object to which access is allowed)

RFC_TYPE (Type of RFC object to FUNC
which access is to be allowed)

S_DATASET (Authorization for file ac-  ACTVT (Activity) 34 (Write)

cess)
FILENAME (Physical file name) * (no specific entry required)
PROGRAM (Program Name with SAPLSTRF

Search Help)

S_TRANSPRT (Transport Organizer)  ACTVT (Activity) 01 (Create or generate)

TTYPE Request Type (Change and CUST

Ti t Syst
ransport System) TASK
/PMO/IBCT (FS-PM: Template for In-  /PMO/APPLI (Application ID) POLICY
Force Business Configurator)

/PMO/ENTIT (Entity ID) *

/PMO/0OPERA (Template Operation)  AIM
DEL
IMP
LOG

REL

/PMO/TMPID (Template ID) *

/PMO/TMPTY (Template Type) *

9. Save your changes.

2.2 Creating a User in FS-PRO

The SOAP message requires a FS-PRO user name and password. You can create a user in the Role Painter of
the Design Time Administrative Console.

® Note

In the Job Title panel, select System. This category includes the authentication required for product web
services.

Integration Guide for Coverage-based Insurance Solutions
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For information about creating a user in FS-PRO, see Working with Job Titles.
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3 Configuring RFC Destinations

3.1 Configuring RFC Destinations in Products

In order to let the system know which destination name will be used in the application, the destination names
need to be defined in the product.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Navigate to the SAP Global Reference Object component and open it.

3. Goto|l Configuration j Integration » RFC » Remote Function System 4.
4. Define the RFC Destination.
A predefined set of system types are provided. You can used the default name or assign a name of your

choosing. This will be the name of the RFC Destination that you will create via a properties file in the
Administrative Console.

System Type From System To System Destination Name
ifbc FS-PRO FS-PM FSPM_DEST

pbt FS-PRO FS-PM FSPM_DEST
policy FS-QUO FS-PM FSPM_DEST
insuobj FS-QUO FS-PM FSPM_DEST
bpartner FS-QUO SAP GP-FS BP_DEST
searchHelp FS-QUO FS-PM FSPM_DEST
generic FS-QUO FS-PM FSPM_DEST

If the required system type isn't listed, you will need to create a new row, with the new system type and a
name.

5. Build the metadata and publish the SAP Global Reference Object.

Integration Guide for Coverage-based Insurance Solutions
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3.2 Configuring RFC Destinations in the Administrative
Console

RFC destination details are configured in a properties file, to allow connections to be integrated into other SAP
systems.

Prerequisites

Confirm the destination names for FS-PM and SAP GP-FS RFC connectivity that's defined in the RFC reference
object in FS-PRO.

They will be referred to as <FS-PM_dest_name> and <BP_dest_name> respectively in the following steps.

The Destination Repository User onthe S/4HANA system must be of the type DIALOG (preferred) or
COMMUNICATION as the connection between FS-QUO and S/4HANA requires the generation of logon tickets
for SSO. Furthermore, the S/4HANA system must be configured to support the generation of logon tickets.
This can be achieved by adding the following to its profile: login/create_sso2_ticket = 2.

Procedure

1. Create a properties file for the FS-PM connection.

a. Open a text editor.

b. Add the following text to the file and add the appropriate JCo client settings in the file with connection
details for the FS-PM system:

jco.client.client=
jco.client.user=
jco.client.sysnr=
jco.client.ashost=
jco.client. lang=

where:
client

Specifies the SAP client number.

Three-digit client number; preserve leading zeros if they appear in the number.
user

Specifies the login user ID.

User name for logging in to the SAP system.

Ensure that the User ID entered here has all of the required permissions in FS-PM.

This is a technical user account. SSO/Principal Propagation is not supported.
sysnr

Integration Guide for Coverage-based Insurance Solutions
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C.

Indicates the SAP system number.

ashost

Identifies the SAP application server.

Host name of a specific SAP application server.
lang

Specifies a login language.

Use the SAP-specific single-character language code.
Save the file as FSPM_DEST . jcoDestination to a local directory.

2. Launch Internet Explorer and go to <quo_runtime_app_url>/csiroot/admin/.

3. Login asthe <admin_user>.
The Runtime Administrative Console will open after a short delay.

4. Upload the files to the file system.

a.

e.

Go to |+ System » Edit File System .

A list of folders appears in the tree, and the folders and files in the selected folder appear in the details
panel.

From the Path dropdown list, select PA - Custom Web Root (Write).
Expand the resource folder in the tree and go to the rfcdestination folder.

. Right-click the rfcdestination folder, and choose Upload.

The Upload Files dialog appears.
Upload both of the destination properties files.

5. Add a new configuration variable for your FS-PM connection password entry.

Sm o a0 oo

In the editor pane, select RFC Standalone Credential Setting from the Configuration dropdown list.
Choose the Add Config Variable button.

Enter FSPM DEST_STANDALONE_PWDin the Name field.

Enter the password for <FS-PM_dest_name> in the Description field.

Ensure that the Mandatory checkbox is deselected.

Enter Encrypt Text inthe Control field.

Ensure that the Enumeration field is blank.

Ensure that the Default field is blank.

Save your changes.

6. Add a new configuration variable for your SAP GP-FS connection password entry.

Sm e a0 oo

In the editor pane, select RFC Standalone Credential Setting from the Configuration dropdown list.
Choose the Add Config Variable button.

Enter BP_DEST_STANDALONE_PWDin the Name field.

Enter the password for <BP_dest_name> in the Description field.

Ensure that the Mandatory checkbox is deselected.

Enter Encrypt Text in the Control field.

Ensure that the Enumeration field is blank.

Ensure that the Default field is blank.

Save your changes.

7. Goto|p Configration » System » Env Jin the configuration tree and select RFC Standalone Credential.

14
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8. Enter the password of the user for the RFC connection to the FS-PM system in the Override field of the
FSPM_DEST_STANDALONE_PWD property and choose Save.

9. Enter the password of the user for the RFC connection to the SAP GP-FS system in the Override field of the
BP_DEST_STANDALONE_PWD property and choose Save.

10. Select |r System ¥ Reload Configuration Setting 4 from the menu bar and choose Reload All Config for the
new password settings to take effect.
Related Information

Configuring RFC Destinations in Products [page 12]

3.3 Testing RFC Destinations

You can verify that the connectivity defined in the destinations is functional.

Context

® Note

This functionality is not available in the Design Time Administrative Console.

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<pro_runtime_app_url>/csiroot/admin/.
The Runtime Administrative Console will open after a short delay.

2. Select|p System » Test SAP Server Connectivity 3.
3. Gotothe Test JCo3 Feature tab, select the destination and choose Connect to test the connection.

4. Repeat these steps for all destinations.

Results

A pop up message indicates whether the connection is valid or invalid.

Integration Guide for Coverage-based Insurance Solutions
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4 Configuration Changes Needed for IFBC
Push

This section describes how to set up the connection between FS-PRO and FS-PM or the replication of static
product data (IFBC Push) into the In-Force Business Configurator (IFBC) of FS-PM.

Before you begin, ensure that the following conditions are met:

1. Inthe SAP Global Reference Objectin FS-PRO, confirm that the "IFBC" system type is configured
and selected in the component |+ Configuration # Integration » RFC » Remote Function System

2. Verify the RFC destination configuration in the Design Time Administrative Console.

3. Verify that the related Custom Publishing Services are selected.

4. Choose Operation Mode for IFBC import.

This replication consists of the following steps:

1. InFS-PRO, send the IFBC structure with the static data of a product to FS-PM.
2. InFS-PM, datais stored in the import buffer.
3. InFS-PM, perform the IFBC import.

Before you can perform these steps, some preparatory configuration steps are required. Data from FS-
PRO is transferred to FS-PM and imported to IFBC by calling the RFC-enabled function module /PMO/
ABC_IBC_RECEIVE_GNRL. This function module is called if you publish a product and the IFBC structure
is sent to FS-PM. Before the function module can be called successfully, you must perform the activities
described in the following subsections.

4.1 Verifying Custom Publishing Services are Selected

Context

The SAP Insurance UWA Product Template object provides the following services that you can run
immediately after a product is published:

Send Structure Info Runstherulesinthe IFBC Integration Services APl in each entity to generate the
to | FBC XML structure that IFBC needs.

Upl oad & Deploy to Uploads the published product JAR to the product repository and deploys it to
Runti me the Runtime environment of the Product Web Services Manager. The WSDL is
generated with the deployment.

By default, these services are selected so that they appear in the Publish dialog. You can choose these services
when you publish the product. Before you publish a product for the first time, check that these services are
selected in your product.

Integration Guide for Coverage-based Insurance Solutions
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Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Navigate the Studio Tree to locate your product.
3. Open the product ﬁ’l :
4. Goto|p <product_name> » Configuration ¥ Product Services » Custom Publishing 3.

5. Ensure that the Send Structure Info to IFBC and Upload & Deploy to Runtime services are selected on the
Values tab.

4.2 Static Product Information for IFBC

For every entity that requires a product template in IFBC, the corresponding information must be configured in
FS-PRO. After a product is defined and published in the Product Modeler, the product structure, including the
corresponding IFBC information, is sent to IFBC using an XML file. The appropriate product templates are then
created in IFBC.

By setting up the corresponding information in FS-PRO and IFBC, new policy and endorsement information can
be transferred between FS-PM and FS-PRO for rating.

For more information about IFBC, entities, and templates, see the SAP FS-PM Application Help.

4.2.1 Types of Entities Provided

The product templates provided in FS-PRO map to IFBC entities provided in FS-PM. For information about the
IFBC template values, see the IFBC application help.

The libraries and product templates that are provided in FS-PRO are split into four lines of business:

®* SAP PnC Insurance Template Library

®* SAP LnA Insurance Template Library

®* SAP AUTO Insurance Template Library

®* SAP Longterm Insurance Template Library

® Note

If you want to define your product to map to IFBC entities that aren't already included in the FS-PRO
libraries, contact your SAP implementation team or SAP Support.

Integration Guide for Coverage-based Insurance Solutions
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4.2.2 IFBC Components in the Product Modeler

In the Product Modeler, all of the main axis and lateral objects in your product include IFBC-related
components that define the information required in IFBC product templates. When defining a product, you
must select values in these components that map to the IFBC templates. This only applies if you are going

to perform an IFBC push from FS-PRO to FS-PM. By using the information in these components, FS-PRO can
traverse the product definition and gather information for the XML file for IFBC.

Related Information

Adding New Fields in FS-PRO [page 92]

4.2.3 Location of the IFBC Components

Each entity in the XML file that is published from the Product Modeler and sent to IFBC includes basic data,
subordinate information, control attributes, and column details. The following table shows where to define this
required information in the Product Modeler:

IFBC Entity Information Where Defined in the Product Modeler

Basic Data (for example, name and ID) | <entity _or_object_name> ¥ Identification ¥ SAP

<object_type_name>|d 3

Example: |} Sample Household Contract > Identification
» SAP Contract Id 3

You must specify the IFBC template ID in this component
using the Templateld field. This value is passed using the
PRODUCT_BASE_ID tag in the XML file. If the object that you
are defining is used in multiple places (for example, in multi-
ple products) and contain data that is unique to its parent
object, you must specify a unique template ID.

For example, if a coverage appears in two contracts with
different control attribute values, the template ID of the cov-
erage in each contract must be different. Otherwise, if the
same template ID is used by the two coverages, the later
import will overwrite the earlier one

Integration Guide for Coverage-based Insurance Solutions
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IFBC Entity Information

Where Defined in the Product Modeler

Subordinates

|} <entity_or_object_name> > Identification } SAP

<object_type_name>/d 4

Example: |} Sample Household Contract > Identification
» SAP Contractid 3

Enter values for the following subordinate information:

* MinCardinality
* MaxCardinality
* Autolnclude Flag

® Note

Subordinate information doesn't apply at the prod-
uct level. Therefore, these columns don't appear

in | <product_name> } Identification # SAP Product
Id } . This is the product-level component.

Control Attributes

|} <entity_or_object_name> > Configuration
> Integration > IFBC <object_type_name> Integration
Services > IFBC Control Attributes ]

Example: |[F Sample Household Contract # Configuration
> Integration > IFBC Contract Integration Services > IFBC
Control Attributes 4

Integration Guide for Coverage-based Insurance Solutions
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IFBC Entity Information

Where Defined in the Product Modeler

Column Details (Characteristics/Marks)

|} <entity_or_object_name> > Configuration
> Integration > IFBC <object_type_name> Integration
Services > IFBC Column Details }

Example: |[F Sample Household Contract # Configuration
> Integration > IFBC Contract Integration Services > IFBC
Column Details ]

If a column detail has a range of values, also define the
following component:

|} <entity_or_object_name> > Configuration

> Integration > IFBC <object_type_name>] Integration
Services ¥ IFBC Column Details  IFBC Column Ranges 4
If a column detail has a default value, also define the follow-
ing component:

| <entity_or_object_name> ¥ Underwriting # SAP
Column Default Values 3

If a column detail has an enumeration list, also modify the
following components:

|} <product_name> > Configuration > Integration > IFBC
Product Integration Services } IFBC Column Lists ]

|} <entity_or_object_name> > Reference Data

» Domain Tables 4

4.3 Defining Static Product Information for IFBC Push

To create a product that works with FS-PRO and FS-PM, you must define the IFBC-related components in the
Product Modeler and specify data that correlates with IFBC product templates.

Proceed as follows:

1. Define product-level IFBC components .

2. Define main axis IFBC components

3. Define lateral IFBC components

4,

5. Publish the product and send the IFBC XML
20 PUBLIC

(Optional) Define IFBC integration services, including setting the language
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4.3.1 Defining Product-level IFBC Components

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.

3. Openthe SAP Product Idcomponent and enter the basic datain a row.

® Note

If this object is used in multiple places, you must change the IFBC template ID specified in the
Templateld field.

4. Open |l Configuration ¥ Integration j IFBC Product/Contract Integration services  IFBC Control
attributes 3 and select the control attributes that apply.

You can override the predefined values with different values.
You can specify a text value for a control attribute in the TextValue field.
To select a value from predefined values, select a value from the DropdownListValue field.
5. Open|k Configuration ¥ Integration » IFBC Product/Contract Integration services » IFBC Column details 3
and enable the check boxes for the characteristics that apply.
You can override the predefined values with different values.

6. If a column detail has an associated range of values, expand the detail row, and do one of the following in

|» Configuration ¥ Integration » IFBC Product/Contract Integration services  IFBC Column ranges J:

* Selectarow.
* Create arow, enter the low and high values of the range, and select the row.

7. If a column detail has a default value, open the SAP Column Default Values component, create a row,
enter the column name and its default value, and select the row.

8. If acolumn detail has an enumeration list, do the following:

a. Inyour company library, go to the | Components » Domain Tables J folder, create an object with a
Modifier Type of Reference, and define the values of the enumeration list in the object.

If the |» Components » Domain Tables 3 folder doesn't exist in your company library, create it.

b. Inyour product, open the IFBC Column Lists component, create a row, and enter information to
define the domain table that you created in your company library.
The ComponentName field specifies the component name that contains the enumeration values. This
value must match the name defined in the domain table component that you created.

c. Goto|p <product_name> » Reference Data » Domain Tables 3 folder, add (search and assemble)
the domain table that you created in your company library.

If the | Reference Data » Domain Tables J folders don't exist in your product folder, create them.
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The |» SAP Insurance Base Library ¥ IFBC Integration Objects » Components » Column Lists J folder
contains predefined domain tables that can assemble in products. In your entity's | Reference Data »
Domain Tables Jfolder, you can add (search and assemble) these domain tables.

d. Open each domain that you assembled and select all the rows.

e. Open the following component and specify the LIST_ID you defined in the IFBC Column Lists:
|l <product_name> » Configuration j Integration  IFBC Product Integration Services ¥ IFBC Column
Details .

Related Information

Location of the IFBC Components [page 18]

4.3.2 Defining Main Axis IFBC Components

For each main axis object (such as contracts and coverages) assembled in your product, you must define the
IFBC-related components.

Procedure

Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.

Open the SAP <object_type_name> 1d component and enter the following basic data in a row:
* Code
* Display Name
* Short Name
* LobCode
* EntityType as per FSPM PBT model
* TemplatelD (A user-configured code the begins with an underscore "_")

® Note

If this object is used in multiple places, you must change the IFBC template ID specified in the
Templateld attribute.

4. Enter the subordinate information in the Min Cardinality, Max Cardinality, and Auto Include Flag attributes.

22

Openthe IFBC Control Attributes component and select the control attributes that apply.
You can override the predefined values with different values.

You can specify a text value for a control attribute in the TextValue attribute.
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To select a value from predefined values, select a value from the DropdownListValue attribute.
6. Openthe IFBC Column Details component and enable the check boxes for the characteristics that
apply.
You can override the predefined values with different values.
7. If acolumn detail has an associated range of values, expand the detail row, and in the IFBC Column
Ranges component, do one of the following:
* Selectarow.
¢ Create arow, enter the low and high values of the range, and select the row.

8. If a column detail has a default value, open the SAP Collumn Default Values component, create a row,
enter the column name and its default value, and select the row.

9. If a column detail has an enumeration list, do the following:

a. Inyour company library, go to the [ Components » Domain Tables J folder, create an object with a
Modifier Type of Reference, and define the values of the enumeration list in the object.

If the | Components » Domain Tables 3 folder doesn't exist in your company library, create it.
b. Inyour product, openthe IFBC Column Lists component, create arow, and enter information to
define the domain table that you created in your company library.

The ComponentName field specifies the component name that contains the enumeration values. This
value must match the name defined in the domain table component that you created.

c. Inthe|l Reference Data » Domain Tables 4 folder, add (search and assemble) the domain table that
you created in your company library.

® Note

The | SAP Insurance Base Library » IFBC Integration Objects #» Components # Column Lists J
folder contains predefined domain tables that can assemble in products. In your entity's

| Reference Data » Domain Tables 3 folder, you can add (search and assemble) these domain
tables.

d. Open each domain that that you assembled and select all the rows.
e. Openthe entity's IFBC Column Details component and specify the LIST_ID you defined in the
IFBC Column Lists.

Related Information

Location of the IFBC Components [page 18]
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4.3.3 Defining Lateral IFBC Components

For each lateral object (such as limits and deductibles) assembled in your product, you must define the
IFBC-related components.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.
3. Openthe SAP <object_type_name> Id component and enter the basic data in a row.

® Note

If this object is used in multiple places, you must change the IFBC template ID specified in the
Templateld attribute.

4. Enter the subordinate information in the Min Cardinality, Max Cardinality, and Auto Include Flag attributes.

5. Openthe IFBC Control Attributes componentand select the control attributes that apply.
You can override the predefined values with different values.
You can specify a text value for a control attribute in the TextValue attribute.

To select a value from predefined values, select a value from the DropdownListValue attribute.
6. Openthe IFBC Column Details component and enable the check boxes for the characteristics that
apply.
You can override the predefined values with different values.
7. If a column detail has an associated range of values, expand the detail row, and in the IFBC Column
Ranges component, do one of the following:
* Selectarow.
* Create arow, enter the low and high values of the range, and select the row.

8. If a column detail has a default value, open the SAP Column Default Values component, create a row,
enter the column name and its default value, and select the row.

9. If acolumn detail has an enumeration list, do the following:

a. Inyour company library, go to the | Components » Domain Tables J folder, create an object with a
Modifier Type of Reference, and define the values of the enumeration list in the object.

If the | Components » Domain Tables Jfolder doesn't exist in your company library, create it.

b. Inyour product, open the IFBC Column Lists component, create a row, and enter information to
define the domain table that you created in your company library.

The ComponentName field specifies the component name that contains the enumeration values. This
value must match the name defined in the domain table component that you created.

c. Inthe|p Reference Data » Domain Tables 3 folder, add (search and assemble) the domain table that
you created in your company library.
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® Note

The | SAP Insurance Base Library ¥ IFBC Integration Objects » Components # Column Lists 3
folder contains predefined domain tables that can assemble in products. In your entity's

|\ Reference Data » Domain Tables 3 folder, you can add (search and assemble) these domain
tables.

d. Open each domain that you assembled and select all the rows.
e. Openthe entity's IFBC Column Details component and specify the LIST_ID you defined in the
IFBC Column Lists.

Related Information

Location of the IFBC Components [page 18]

4.3.4 Defining IFBC Integration Services

Optionally, you can modify the rules that define the values for the IFBC Import Mode Code and Clear Table Flag.

Context

When you are replicating a product from the Product Modeler into FS-PM via an IFBC Import, you will need to
set a Language Code for the product if a language other than English is used.

You can also enter comments to publish as part of the XML file for IFBC. These comments provide additional
information about the product import.

These settings are defined at the product level.

A Caution

The definition at the product level includes an IFBC Integration Services API component. Don't
modify the rules in this component. These rules traverse the product tree and retrieve the basic data,
subordinates information, control attributes, and column details for each entity in the tree.

A Restriction

Do not edit or use the following rules: getFieldByEntityType, getProductAttributes,
getProductEntities, getProductlLanguage, getProductLists, and getProductMarks
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Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.

3. Goto|p <product_name> » Configuration ¥ Integration % IFBC Product Integration Services ¥ IFBC

Integration Services APl 3.
4. Modify the Import Mode Code or Clear Table flag:

a.
b
c.
d. Uncomment the value that you want to assign to the setting, and comment out the other output

b 0]

Find and select the getimportModeCode or getClearTableFlag row.

. Right-click and select Override on the menu.

Open the rule in Rule Painter.

values.
Save your changes.
Build the rule.

5. Enter a comment for the product import:

- 0o o0 0w

Find and select the getComment row.

Right-click and select Override on the menu.

Open the rule in Rule Painter.

In the result variable, enter a comment for the product import.
Save your changes.

Build the rule.

Related Information

Choosing Operation Mode for IFBC Import in FS-PRO [page 26]

4.4

Choosing Operation Mode for IFBC Import in FS-PRO

In FS-PRO, you must choose the operation mode for the IFBC import.

The following operation modes for the IFBC import are possible:

IV_IMPORT_MODE_CD ='0": This operation mode only tests the RFC interface (/PMO/

ABC_IBC_RECEIVE_GNRL).

No data will be stored in the import buffer and thus no data can be imported
into IFBC.

IV_IMPORT_MODE_CD ='1": This operation mode stores data in the import buffer.

26
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You can import these stored data only manually into IFBC at a later time.

IV_IMPORT_MODE_CD ='2": This operation mode stores data in the import buffer and starts the IFBC
import automatically in simulation mode.
You can perform the IFBC import manually as an update run at a later time.

IV_IMPORT_MODE_CD ='3": This operation mode stores data in the import buffer and starts the IFBC
import automatically as an update run.

Where to choose the operation mode

See Defining IFBC Integration Services [page 25].

When to use which operation mode

* Use operation mode '3'if there is no indication that unexpected side effects may occur, for example after
minor changes to product modules on the FS-PRO side.

¢ Use operation modes '1' and '2' during the development of new products to keep the risk low that the
automatic import of a new product invalidates existing product templates.

4.5 Productive System Landscape

Context

For the integration of FS-PRO and FS-PM, a productive system landscape should consist of the following ABAP
systems:

* Development system

* Consolidation or quality system

* Production system

If you send the IFBC structure from FS-PRO to FS-PM, the data should be sent to an appropriate client of the
development system. This client must be able to forward IFBC content to subsequent systems in the landscape
(for instance, through the consolidation system to the production system). Consequently, the client must be
set up in a way that it enables it to handle transport requests.
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Procedure

1. Check the client settings in the development system as follows:

a. Call up transaction SCC4.
b. Select the relevant client.

c. Choose the % Details icon.

d. In Changes and Transports for Client-Specific Objects section, ensure that the Automatic recording of
changes radio button is enabled.
Only if this isn't the case, perform the following step 2.

2. Configure IFBC for mandatory transports.

a. Choose Define Template Type in Customizing for Policy Management under | In-Force Business

Management # Basis  In-Force Business Configurator .
b. Forthe application ID Policy and template type 1 (Product Template), set the transport options to
Transport mandatory .

Results

Once the systems are set up, the publishing of a product in FS-PRO leads to the creation of a transport request.
This transport request must be released in the development system once the product templates fulfill the
requirements of the product model. Afterward, you can verify the quality in the consolidation system. Once all
of the tests that you have performed with your product have the green status, the collected transports can be
sent out to the production system.
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5 Configuration Changes Needed for FS-
PRO Runtime

5.1 Customizations in SAP Policy Management

5.1.1 Defining Product Module Groups for Runtime Adapter

The configuration of new products in FS-PRO (or any other product engine) results in new product modules
for the product model classes of the coverage-first data model (such as sales product, product, elementary
product or subcoverage).

Context

A product module is tagged with a unique product module ID that has to be assigned in the IFBC control

attributes of the respective product module. The product module IDs are part of the static product information

that is imported into IFBC.

If a new IFBC product template has been created during import, the following applies: The new product module

ID must be assigned to new or existing product module groups in FS-PM so that the Customizing settings

defined in the product module group Customizing of FS-PM become effective. Without this assignment, policy

processing in FS-PM will raise error messages for the new unassigned product modules.

You can find the Customizing activity Define Product Module Groups in Customizing for Policy

Management under |» In-Force Business Management » Basis » Basic Settings

Procedure

1. Select the group dimension INTPM (Integration of Product Manager) and double-click Assign Product
Model Class to Group Dimension.

2. Select the product model class PRODUKT and make the following entries:
a. At Product Module Groups level, define a product module group, such as FSPRO.

b. At Assignment of Product Module ID to PBS Groups level, assign the product module ID _CONHHLD to

product module group FSPRO.
3. Select the product model class VERKAUFSPRODUKT and make the following entries:
a. At Product Module Groups level, define a product module group, such as FSPRO.

b. At Assignment of Product Module ID to PBS Groups level, assign the product module ID _POLHHLD to

product module group FSPRO.
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5.1.2 Assigning Implementation Classes to Product Engine
Interfaces

You can find the Customizing activity Assign Implementation Classes to Product Engine

Interfaces in Customizing for Policy Management under ||» Integration » Product Engine 3.

Make the following entries for the new product module group FSPRO (which means the product engine FS-
PRO):

Interface Name Entity Implementation Class to Be Assigned

/PMO/IF_ABR_PM_UTILITY /PMO/ABDAPOLICY /PMO/CL_ABH_PM_UTILITY

(Analyzes IFBC entries at runtime)

/PMO/IF_ABR_PM_UTILITY /PMO/ABDAPOLPR /PMO/CL_ABH_PM_UTILITY

(Analyzes IFBC entries at runtime)

/PMO/IF_APP_MAP_PRO /PMO/ABDAPOLICY /PMO/CL_APP_MAP_PRO

(Implementation of the mapping for the
service request and service response)

/PMO/IF_APR_PM_CALCULATION /PMO/ABDAPOLPR /PMO/CL_APH_PM_CALCULA-

TION_PRO
(Product engine interface that is called -

from within FS-PM)

® Note

The Entity field determines if the product module group is interpreted as product module group on sales
product level (corresponds to entity /PMO/ABDAPOLICY) or as product module group on product level
(corresponds with entity /PMO/ABDAPOLPR).

5.2 Technical Information for Integration

All entity structures in the Service Consumer PRODUCT (ABAP Class /PMO/CO_PROXY_PWS_PRO) contain
the field RUNTIME_OBJECT_ID. This field identifies each entity instance.

CREATE: Incase FS-PRO creates a new entity (for instance, it attaches a new clause), the value of the field
RUNTIME_OBJECT_ID is initial.

CHANGE: The RUNTIME_OBJECT_ID that is passed from FS-PM to FS-PRO must remain unchanged in
FS-PRO.

DELETE: If an entity instance is passed from FS-PM to FS-PRO, but not returned to FS-PM, it will be deleted
in FS-PM.

Integration Guide for Coverage-based Insurance Solutions
30 PUBLIC Configuration Changes Needed for FS-PRO Runtime



Processing of Entities

In the following table, you can find a description of how any product engine should process the FS-PM entities.

For example:

* Inthe operation PCRATING, the product engine isn't allowed to insert or delete a coverage. However, the
product engine is allowed to update a coverage.

* Inthe operation PCRATING, the product engine is allowed to insert, update, and delete a clause.

RATING MOD_CONTRACT ADJUSTMENT MIGRATION ACCOUNTREPVAL
Enitity Insert Update Delete |Insert Update Delete|Insert Update Delete JInsert Update Delete|Iinsert Update Delete
yes yes yes yes yes yes yes yes yes yes  yes yes yes yes yes
CLAUSE yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes
cov no yes no no yes no no yes no no yes no no yes no
COVCPCO yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes
COVPAC no yes no no yes no no yes no no yes no no yes no
DEDCTBL yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes
yes yes yes yes yes
yes yes yes yes yes
LIMIT yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes
POLICY no no no no no no no no no no no no no no no
POLPR no yes no no yes no no yes no no yes no no yes no
PPDPAC no no no no no no no no no no no no no no no
yes
PREM no yes no no yes no no yes no no yes no no yes no
PREMTAX yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes
yes yes yes yes yes yes yes yes yes yes  yes yes yes yes yes
SBADR no no no no no no no no no no no no no no no
SUBICT no yes no no yes no no yes no no yes no no yes no
SUPDC yes yes yes yes yes yes yes yes yes yes yes yes yes yes yes

5.3 Credential Handling from FS-PM to FS-PRO

This section describes the configuration of the point-to-point connection between the FS-QUO/FS-PRO
Product Web Services (PWS) provider and the corresponding FS-PM product web service consumer.

The Product Web Services are SOAP web services. The service interface contains five synchronous service

operations. They follow a query response Transaction Communication pattern. In particular, no data from

FS-PM is persisted in FS-PRO.

Integration Guide for Coverage-based Insurance Solutions
Configuration Changes Needed for FS-PRO Runtime

PUBLIC

31



In the following graphic, you can see the Product Web Services in both systems and the corresponding service
operations:

FS-PM FS-PRO
Deployment Unit Deployment Unit
Insurance Policy Management Rating Engine
Process Component Process Component
Product Web Service Product Web Service
Interface Outbound Interface Inbound

pcRatingWSRequest

PC_RATING_WS

- .’ pcRatingW's

m Qutbound Operation ‘ Inbound Operaticn m
-|_| pcRatingWSResponse H_I
I_q pcModContractWSRequest |_L
PC_MOD_CONTRACT_WS - .’ pcModContractWs
m QOutbound Operation Inbound Operation m
—|_| pcModContractWSResponse k_l
Property
::,I: ¥ I_q pcAdjustmentWSRequest I_L
Casualty PC_ADJUSTMENT_WS - pcModContractWs .
Insurance - Outbound Operation ia Inbound Operation B oo Rating
Application -|_| pcAdjustmentWSResponse k_l
rﬂ pcMigrationWSRequest I_L
PC_MIGRATION_WS - -’ pcMigrationWs
m Outbound Operation ‘ Inbound Operation m
-|_| pcMigrationWSResponse k_l
l_q pcAccountRepValWWSReguest I_L
PC_ACCOUNT_REP_VAL_WS = _’ pcAccountRepValWs
Inbound Operation m

pcAccountRepValWSResponse

m Outbound Operation I |

FS-PRO implements a PWS. FS-PM implements the counterpart consumer Product Web Services /PM0O/
CO_PROXY_PWS_PRO. This consumer Product Web Services is part of FS-PM standard implementation and
doesn't need to be created on the customer side.

5.3.1 Authentication for Product Web Services

A message-based authentication is required for the Product Web Services. User credentials such as user name
and password are passed in the wsse header of a SOAP envelope. In case of an HTTP request, the SOAP
envelope is embedded in the HTTP body. A SOAP action in the SOAP header specifies the required service
operation.

Maintenance and, in particular, the adding of credentials for a point-to-point connection is handled by
defining a logical port in the FS-PM system of a customer system landscape. The logical port represents
the counterpart consumer of the PWS provider FS-PRO system of a customer system landscape.

SOAMANAGER generates a port based on a concrete (binding) Web Services Description Language (WSDL) for
an endpoint. It contains the following information:

* Functional descriptions

* Transport binding information, such as the URL and access path

* Product web service - policy information
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Consumer System Provider System

Enterprise Service
Consumer

Enterprise Service

Logical Port —p Endpoint

Related Information

Providing a WSDL for Product Web Services Endpoint at Customer Site [page 33]

5.3.2 Providing a WSDL for Product Web Services Endpoint
at Customer Site

You must create and store a concrete (binding) WSDL for an FS-PRO Product Web Services endpoint at the
customer site.

Prerequisites

Before you generate the WSDL, check that the following settings are configured:

* Inthe FS-PRO Design Time Administrative Console, the location of the Product Web Services Manager
is specified, and the PrePostPubl ishingEnabled setting is set to Yes. For information about these
settings, see PC > Env > PC Environment.

* Inthe Product Modeler, the Upload & Deploy to Runtime service is selected in your product's Custom
Publishing component.

Integration Guide for Coverage-based Insurance Solutions
Configuration Changes Needed for FS-PRO Runtime PUBLIC 33


https://help.sap.com/docs/Quotation_and_Underwriting_for_Insurance/cb982ba68d8b4a8181e63b611c7578ab/ba6ce47216f04cf6a12448bedc657943.html?version=1.1.00.0

Procedure

Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Publish the product.

3. Launch Internet Explorer and log in to the Design Time Administrative Console at the following location:

<pro_designtime_app_url>/csiroot/admin/.

The Design Time Administrative Console will open after a short delay.

4. Goto|p Product ¥ Manage Product Web Services .

5. Choose the Runtime tab.

6. Inthe left panel, choose the name of your product (for example, Sample Household ProductA web service

document appears in the right panel).

Choose WSDL.
A browser window opens, showing the WSDL file.

Copy the URL from the browser address bar.

This URL is required when defining a port for a Product Web Services provider endpoint.

Related Information

Verifying Custom Publishing Services are Selected [page 16]

5.3.3 Defining a Port for a Product Web Services Provider

Endpoint

As a prerequisite for maintenance and adding credentials for a point-to-point connection, you must define a
port for a Product Web Services provider endpoint.

Procedure
1. Call up transaction SOAMANAGER in FS-PM.
2. Select Web Service Configuration on the Service Administration tab,
The Web Service Configuration screen appears.
3. Inthe Search Criteria section, enter the object name / PM)/ CO_PROXY_PW5_PROand choose Search.
4. Select the internal name /PMO/CO_PROXY_PWS_PRO from the Search Result.
5. Onthe Configurations tab, select | Create » WSDL Based Configuration 3.
6. Enter the Logical Port Name according to your requirements. If required, select the Logical Port is Default
checkbox and choose Next.
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® Note

A single logical port must be defined as the default port.

7. Read the Product Web Services concrete (binding) WSDL.

To do so, enter the URL and the credentials (user name and password) for WSDL access.

® Note

You can find the URL of the WSDL location in the Design Time Administrative Console. For more
information, see Providing a WSDL for Product Web Services Endpoint at Customer Site [page 33].

8. Select the binding entry in the Overview of Possible Combinations Identified by WSDL Document section.
9. Enter the credentials (user name and password) for the SOAP message-based authentication.

10. If required, adjust the transport binding data. For example, if you change the URL protocol information, you
must adapt the port accordingly.

11. Onthe next tabs, choose Next until you reach the Operation Settings tab.
12. Choose Finish.

Related Information

Providing a WSDL for Product Web Services Endpoint at Customer Site [page 33]
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6 Configuration Changes Needed in FS-
QuUO

6.1 Configuring the Connection in FS-QUO

To send policy XML from FS-QUO to FS-PM, you must configure FS-QUO with the proper connection details.

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<pro_runtime_app_url>/csiroot/admin/.
The Runtime Administrative Console will open after a short delay.

2. Navigate to ||» Configuration » Application » AuthoritySuite ¥ Env » FS-PM Integration Setting

3. Foreachrow, set the Override attribute to a value that corresponds to the FS-PM environment, and save.

* Get the values to enter from FS-PM. The values must match in both environments.

* The FS-PM database only allows three login attempts using the jco.client.user and jco.client.passwd
values. If the login fails after three attempts, the database access locks and you will need to contact
the DBA.

4. Navigate to |+ Configuration » Application » AuthoritySuite » Env » Application Environment
5. Find the FSPMBookingServiceEnabled row, set the Override attribute to Yes, and save.
6. Reload the configuration settings.

a. Choose |Jr System ¥ Reload Configuration Settings . from the menu bar.
b. Choose Reload All Config.

6.2 Use of XSLT Transformation

In an integrated environment with FS-PM, when a producer or underwriter issues a policy in FS-QUO, a policy
XML is generated. To create a corresponding policy in FS-PM, the following occurs:

* When a policy is bound in FS-QUO, FS-QUO sets the composite keys that FS-PM needs in the URS
(memory representation of the policy model), FS-QUO gets the values for the composite keys from
the product tables. To determine which values to get, FS-QUO references the APIF Composite Key
Configuration component in the Product Modeler.
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The following figure shows the composite key configuration for the ABDAAGENT table:

FS-QUO populates the AGENT_ID column of the ABDAAGENT table in the URS with the unique identifier,
PK_ID, from the ABDAAGENT product table. FS-QUO also populates the POLICY_ID column of the
ABDAAGENT table in the URS with the SECPOL_ID of ABDAAGENT product table's parent.

By default, personal P&C products are configured to reference the SAP Global Reference Object that
contains the APIF Composite Key Configurationcomponent. This reference is configured using the

GlobalReferenceProductName key in the following component: [ <product_name> » Configuration
Config 3.

® Note

The APIF Composite Key Configuration componentis already configured with the entities
that are used for household products. You don't need to modify this component when configuring
household products.

FS-QUO creates the policy XML from the URS.

FS-QUO uses XSLT to transform the policy XML into a format thatFS-PM can consume. FS-QUO provides
an XSL style sheet that includes the entities used for Sample Household.

The transformed data is sent to FS-PM using INPI services.

® Note

If you want to add a field to FS-QUO, you must modify the XSL style sheet. For more information about the
steps involved in this enhancement scenario, contact your SAP implementation team or SAP Support.

6.3 Using INPI Services

INPI services are required for use with products using msg.PM as the rating engine.

In order to book a new business transaction to FS-PM, the policy data captured in FS-QUO requires to be
transformed to the format that INPI services function module can process.

Notes:

PAGNO_ID is a mandatory INPI field. It is used to ensure that a policy is created once in FS-PM. The field
value can be specified in the URS; if not, a default value is assigned by FS-QUO.

The Application Date (APPL_DT) and Application Receipt Date (APPLIN_DT) fields are mandatory INPI
fields. The field values can be specified in the URS; if not, the current system date will be used by default.
Store the policy ID returned by FS-PM in ABDAPOLICY.POLICYNR_TT field in FS-QUO. Use the APIF Output
Parameters to map the value returned by FS-PM to the corresponding field in FS-QUO.

Create the URS policy data XML as well as the corresponding transformed data XML and write them into
file system when WriteFSPMPol icyDataToFi le configuration is enabled.
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6.3.1 Remote Functions Parameters Mapping Configuration

All parameter mappings for all RFCs are maintained within the Remote Functions Parameters Mapping
component.

The fields are mapped within the SAP Global Reference Object within FS-PRO under the following location:
|» Configuration ¥ Integration » RFC » Remote Functions Parameters Mapping 3.

Within the Values tab, there are 3 anchored rows. Each anchored row contains a subset of configuration values
pertaining to the sub-components APIF Input Parameter Mapping, APIF Composite Key Configuration, APIF
Transient Fields, APIF Reserved Fields and APIF Output Parameter Mappings as follows:

update Contains all parameters pertaining to update operations.
These operations only apply to products that use FS-PM for quotation calculation.

create Contains all parameters pertaining to create operations.

These operations only apply to all products.

calculate  Contains all parameters pertaining to calculate operations.

These operations only apply to products that use FS-PM for quotation calculation.

Related Information

Using FS-PM for Quotation Calculation [page 67]

6.3.1.1 Mapping INPI Input Parameters

During transformation, FS-QUO will process each table in the URS policy model and determine whether to
include the table in the INPI payload based on the presence of Input Parameter. If a table name is found in the
configuration, FS-QUO will retrieve the corresponding input parameter name and add the resulting parameter
name and records of data of the table into the INPI payload.

The APIF Input Parameter Mapping component located within |l SAP Global Reference Object

» Configuration ¥ Integration » RFC » Remote Functions Parameters Mapping 3 contains two columns that need
to be mapped to equivalent FS-PM values:

InputParameter Contains the input parameter for table groups in the INPI payload.

TableNames Contains a list of the FS-QUO table names.
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6.3.1.2 Mapping INPI Composite Keys

The composite keys are used by FS-PM to reconstruct the hierarchical structure of a policy model from a flat
structure. FS-QUO gets the values for the composite keys from the associated table and sets them in the URS
policy model.

To determine which value to get and which field to set, FS-QUO references the APIF Composite Key
Configuration componentin the Product Modeler.

The APIF Composite Key Configuration component located within |j¢ SAP Global Reference Object

Configuration ¥ Integration » RFC » Remote Functions Parameters Mapping . contains four columns that need
to be mapped to equivalent FS-PM values:

TableName Contains the FS-PM table name, as used by FS-PRO.
SourceColumnName Contains the source column name in FS-QUO.
TargetColumnName Contains the target column name from FS-PM.

Order Defines the order in which the composite keys are returned back from FS-PM so that
they can be mapped correctly.

This attribute only applies to products that use FS-PM for quotation calculation.

A Caution

Don't change the sort order. If you create a new entity within FS-PM, the composite
key sort order needs to be considered.

6.3.1.3 Mapping INPI Transient Fields

There are fields in the FS-PRO data model that don't exist in the FS-PM data model. These fields need to be
excluded from INPI booking services. These fields are called transient fields and need to be identified.

The APIF Transient Fieldscomponent located within |j» SAP Global Reference Object » Configuration

Integration » RFC » Remote Functions Parameters Mapping . contains two columns that need to be mapped to
equivalent FS-PM values:

TableName Contains the FS-PM table name, as used by FS-PRO.

TransientColumnNames Contains the list of fields to be excluded from INPI payload for the corresponding
table name.

6.3.1.4 Mapping INPI Reserved Fields

There are fields in both the FS-PRO and FS-PM data models that are expected to be empty by the INPI services
function module. These fields are called reserved fields.
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If the reserved fields aren't empty, the function module will raise an exception. This configuration is maintained
separately from Transient Fields configuration for update purpose.

During transformation, FS-QUO will exclude the reserved fields from the INPI payload. To determine which
table name and fields to be marked as reserved for the INPI payload, FS-QUO references the APIF Reserved
Fields Configuration componentin the Product Modeler.

The APIF Reserved Fields component located within | SAP Global Reference Object » Configuration

» Integration » RFC » Remote Functions Parameters Mapping 3 contains two columns that need to be mapped to
equivalent FS-PM values:

TableName Contains the FS-PM table name, as used by FS-PRO.

ReservedColumnNames Contains the list of fields to be marked as reserved for the INPI payload XML for the
corresponding table name.

6.3.2 Mapping INPI Import Parameter

Additional parameters can be specified which direct how the INPI services issued quotes are handled by the
FS-PM system. For example, when booking a quotation in FS-QUO it's typically imported into FS-PM as a
Released policy. However there are circumstances where the booked quotation should be imported but in an
Application state.

® Note

The following configuration doesn't apply to products that use FS-PM for quotation calculation.

The leading Parameters section in the INPI XML contains the Import Parameter details for the booked
quotation.

The APIF Import Parameters component within the SAP Global Reference Object contains five
columns that are mapped for INPI services booking:

InputParameter Contains the parameters that direct handling of the INPI services in FS-PM.

ValueType Indicates the value that is passed in the XML. This control is a dropdown list and the
possible values are as follows:

Default The default FS-PM parameter value is used.
Static  Sets the parameter value from the StaticValue column.

Rule Sets the parameter value from the rule defined in the ServiceAPIName column.

StaticValue Contains the user-defined static value.
ServiceAPIName Contains the user-defined rule.

Arguments Contains the user-defined arguments.
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Related Information

Using FS-PM for Quotation Calculation [page 67]

6.3.3 Mapping INPI Namespaces

Namespace details aren't stored within the FS-PRO or FS-QUO data models. However when booking a
quotation to FS-PM, the prefix needs to be included for fields with a namespace other than “PMO".

The Namespace Mapping componentinthe SAP Global Reference Object allows for the configuration
of these field / namespace mappings. The component contains 2 columns that need to be configured:

QualifiedColumnName Specifies the data model field with a namespace other than PMO.

NameSpace Specifies the namespace prefix that will be appended to the field name in the INPI
services XML.

® Note

Al INPI fields with a namespace other than “PMO” should be configured in this component.

INPI payload creation will look up the mapping in this component to send the correct namespace at the time of
booking

6.3.4 Currency Scaling and INPI Services

Currency scaling is a mechanism within the INPI services XML export process. This mechanism adjusts
currency values to ensure the correct decimal place scaling within the source (FS-QUO) and target (FS-PM)
systems.

For more information about defining currency scaling, see Understanding Currency Scaling.

6.3.5 Using the Business Partner Search Adapter in FS-PM

To use the search adapter of SAP Business Partner for Financial Services (SAP GP-FS) in FS-PM, you must
copy the search helps from FS-PM to SAP GP-FS. For more information, see SAP Note 2020087 ¥ .
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7 Configuration Changes Needed in SAP
GP-FS

The procedures in this section are required only if you are integrating FS-QUO with FS-PM and FS-PRO.

SAP Business Partner for Financial Services (SAP GP-FS) manages business partner data (for example,
account names and addresses). To create new business partners from FS-QUO (for example, add an account),
FS-QUO must be able to connect to SAP GP-FS. When an underwriter or producer adds a business partner in
FS-QUO, FS-QUO sends a request to SAP GP-FS. SAP GP-FS creates the partner and returns the new partner
ID to FS-QUO. FS-QUO stores this partner ID and sends this information along with the policy data at binding
time.

Important:

There may be multiple instances of Business Partner in the landscape. FS-QUO must be connected to the
Business Partner that the corresponding FS-PM is connecting to. FS-QUO searches for Business Partners
(Policy Holder, Premium Payer, etc.) from the connected Business Partner and adds Business Partner to the
connected Business Partner instance.

For example, suppose that you create a business partner for FS-QUO, but searching for a partner doesn't
produce results. This might mean that FS-QUO is connected to SAP GP-FS, but there is a connection issue
between FS-PM and SAP GP-FS. As another example, if you can't create an account in FS-QUO, there is a
connection issue between FS-QUO and SAP GP-FS.

For more information about SAP GP-FS, see the FS-PM Application Help.

71 Enabling the Business Partner Setting

You can enable the business partner setting in the Administrative Console.

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<pro_runtime_app_url>/csiroot/admin/.
The Runtime Administrative Console will open after a short delay.

2. Navigate to ||» Configuration » System » Env » Business Partner Setting

3. Locate the BusinessPartnerEnabled row and set the Override attribute to Yes.

4. Reload the configuration settings.

a. Choose || System » Reload Configuration Settings i from the menu bar.
b. Choose Reload All Config.
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8 Setting Up Product Replication from FS-

PM

You can use out-of-the box templates to inherit from and create your own templates and use these for your
IFBC template replication from FS-PM.

There are four items you can import from FS-PM:

IFBC templates

PBT channel model structures

Non-IFBC relevant entities (Global domain tables)
CBO-customizing tables

Before you import the templates, you must complete the following prerequisites:

Configure RFC destinations in products
Configure RFCs destinations in the Administrative Console

Map the IFBC Template Import

8.1 Mapping the IFBC Templates

Before attempting to import, you need to map the templates that comprise an FS-PM product to the
corresponding target parent template within FS-PRO.

Context

Mapping can be done either manually or by importing a comma delimited file. If a CSV file for a specific product
has been configured and loaded it will supersede any manual configurations in the target template.

Notes:

You only need to perform this task for the products you intend to import from FS-PM.

You must complete all preparation work before you can use IFBC import.

Only those templates that have been specified in the Module Configuration or CSV Configuration are
eligible to be imported and assembled in FS-PRO. This may result in a partial import of a product.

When a template is imported, the Primary Language value for the template is determined by the value
of the GlobalPrimaryLanguage setting. For more information about the GlobalPrimaryLanguage
setting, see System > Env > Globalization Setting.

If you want to import a template in multiple languages, you would define this in the ImportLang value.
Goto| PC » Env » IFBC Replication Setting . inthe Design Time Administrative Console and include a
comma-delimited list of the languages to be imported.
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Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Go to the Product Repository in Product Studio.

3. Create a folder called Template Library and label the Modifier Type as Configuration Group.

4. Create a Components folder in the Template Library folder, for the enum list import and label the
Modifier Type as Component Folder.

5. Create afolderinthe Template Library folder for each Object Modifier Type (from FS-PM).
For example, Contracts, Coverages, Premiums, Policyholders, and so on.

6. Create one template inside of each folder that you created using the following naming convention:
<company_name><LoB><object>template based on the SAP <LoB><object>template.

Each folder should contain the template for the correct LoB and Object that you want to import such as
LnA for Life Product Import or PnC for PnC Product Import.

For example, in the Premiums folder if you want to import a Life line business product, you must create a
new object with the following details:

* Name: ABC Company LnA Premium Template

* Modifier Type: Premium

* Based On: SAP LnA Premium Template

There are three objects which are common across all lines of business, and their naming convention uses
Common instead of LoB, such as the SAP Common Premium Payer Template. For these objects you must
create a new object with the following details:

* Name: ABC Company Common Premium Payer Template

* Modifier Type: Premium Payer

* Based On: SAP Common Premium Payer Template

7. If you want to manually assign the template ID, perform the following steps:
a. For each template that you created, double-click the template to open it.
b. Choose the Identification folder from the Product Tree and select SAP <object>id.

c. Select the ProductModuleld column on the Values tab, and fill in the values for the product template
IDs from FS-PM for the object category that you want to import.

If more than one template ID exists, separate each ID with a comma.

8. If you want to assign the template IDs by importing the information from a CSV file, perform the following
steps:

a. Create a CSV file for a single product and name the file using the following format
<product_name>SalesProductTemplatelD.csv.

There must be one blank space in the file name, after the product name value.

b. Populate the file with the following values for each template occupying a single line and separated by a
comma:

* Parent Template
¢ Template Version
* ProductModulelD

The order in which the templates are listed in the file won't affect the import.

Integration Guide for Coverage-based Insurance Solutions
44 PUBLIC Setting Up Product Replication from FS-PM



c. Save your changes.

d. Launch Internet Explorer and go to <pro_designtime_app_url>/csiroot/admin/.
The Design Time Administrative Console will open after a short delay.

Go to |+ System » Edit File System 1.

Go to | PA - Custom Integration Folder (Write) » productengine .
Create a sub-folder under productengine named replication.

]

> @

Upload the CSV file to the replication folder.
i. Save your changes.

9. Repeat these steps for all objects you want to import.

Next Steps

Ensure that all the templates belonging to the Sales product that you are trying to import are released in FS-PM
before you attempt to import the product in FS-PRO.

8.2 Importing IFBC Templates in FS-PRO

After you complete the prerequisites, you replicate the products that were created from the templates and then
begin the template import process.

Prerequisites

Only those templates that have been specified in the Module Configuration or CSV Configuration are eligible to
be imported and assembled in FS-PRO. This may result in a partial import of a product.

Context

® Note

Choose Refresh List to retrieve an updated list of available products from FS-PM.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
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The Product Modeler will open after a short delay.

Choose | Tools » Product Replication J from the menu bar.
The Product Replication window appears.
Choose the IFBC Import tab.

This tab contains a list of available FS-PM product templates that you can import. You can also search for a
template by Template ID or Template Name.

The following list provides descriptions of the IFBC Import columns:

Template ID

Template
Name

Delta Check

Last Import
in FS-PRO

Status

The identification number for the template.

The name of the FS-PM template that you can import.

If the template name contains any special characters, they will be replaced with a blank
space during import into FS-PRO. For example, a template named 'New+Coverage' will
become 'New Coverage'.

If the first character of the template name is a special character, it will be stripped from
the name during import into FS-PRO. For example, a template named '+NewCoverage' will
become 'NewCoverage'.

If the template name begins with a numeric character, it will be converted to its text
equivalent during import into FS-PRO. For example, a template named '33NewCoverage'
will become '"Three3NewCoverage'.

The pop up window for Template Update that reconciles old and new templates and
makes a recommendation whether or not to import.

See the Performing a Delta Check [page 47] topic.

The date and time when templates were last imported.

The status of the template.
The possible values are:

Success All IFBC templates that were configured in FS-PM were successfully
imported and assembled in FS-PRO.

Failed Errors were encountered during the import.

In Progress The IFBC templates are in the process of being imported and assembled or
updated in FS-PRO.

Continue A partial import was performed, based on templates that were configured in
FS-PRO.

There remain templates that haven't been imported, assembled or updated
in FS-PRO.

4. Select the checkboxes to the left of the Template ID column for the templates that you want to import.

46

Optionally, use the ID Update button to update the cardinality values on the ID records for all assembled
templates under the product.

Choose Import.

While the import is being executed, each template is assigned a status of In Progress and the checkbox for
the template is deselected.
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® Note

You can only import five products at a time. Otherwise, you receive an error message. Note that the
import process could take some time if the templates have a large amount of content.

Next Steps

Perform a Delta Check, if necessary.

8.2.1 Performing a Delta Check

A delta check is a process that reconciles old and new templates.

The delta check tells you when the product was last imported and updated and makes sure that FS-PM and
FS-PRO have the same version of the product. It also makes a recommendation as to whether or not an import
should be attempted.

Notes:

¢ Animport must have been performed before a delta check can be attempted.

¢ Adelta check doesn't delete templates; it just makes recommendations. You must manually delete
templates, if needed.

When you select the icon in the Delta Check column, the Template Update window appears with the following
information:

Template ID The identification number for the template.
Template Name The name of the FS-PM template that you can import.
Last Update in FS-PM The date and time when templates were last updated.
Last Import in FS-PRO The date and time when templates were last imported.
Import Required System recommendation if import is required.

® Note

When a subordinate template is flagged as deleted in FS-PM, FS-PRO will disassemble that template
from the product (parent template). This means that the subordinate template isn't deleted, but that the
relationship between the product and the template is severed.
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8.3 Importing PBT Tables

On the PBT Import tab, you import PBT tables. If you don't see the table you want, you can also search for a
table by Table Description.

Context

Once you import a column the first time in FS-PRO, any changes you make to this column in FS-PM must be
done manually in FS-PRO.

® Note
Namespace details aren't stored within the FS-PRO or FS-QUO data models.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Choose | Tools j» Product Replication 7 from the menu bar.
The Product Replication window appears.

3. Select the templates on the PBT Import tab that you want to import by selecting the checkbox to the left of
the Table Description column.

® Note

If you want to import any tables that aren't in the list, contact SAP development.
4. Choose Import.

A Restriction

Don't delete any items from the system repository or issues can occur. SAP isn't responsible for items
you delete from the system repository.

The following list describes the PBT Import columns:

Table Description The name of entity that you are importing from FS-PM.
Table Name The name of the table you are importing. Each table name begins with one of
the following prefixes, based on the type of product:
* ABDA-Basis
* APDA-P&C
* ALDA-Life
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* MDA-Auto

SAP Data Definition The location where the columns are getting stored.
Name

® Note

You can import new columns that you added to the table in FS-PM.

Last Import in FS-PRO  The date and time when templates were last imported.

Status The status of the template (Success or Fai led).

8.3.1 Understanding Column Updates and the PBT Import

During an import of PBT tables, there are some circumstances in which updates may not be applied to the
Type, Length and/or Precision values for existing columns:

Type value changes in FS-PM aren't applied if the prior Type is TEXT, DATE, BOOLEAN or CLOB.

Type value changes in FS-PM are applied when changing between number types (NUMBER, CURRENCY).

For TEXT Type columns any increases in Length are applied. Decreases aren't applied.
For NUMBER and CURRENCY Types, increases in Length are applied provided that the increase isn't less
than the Precision increase. For example:
* If Length value increases by 2 and Precision value increases by 1, then the Length value increase is
applied.
* If Length value increases by 2 and Precision value decreases by 2, then the Length value increase is
applied.
¢ If Length value increases by 2 and Precision value increases by 3, then the Length value increase isn't
applied.
For NUMBER and CURRENCY types, increases in Precision are applied provided that the increase is less
than or equal to the Length increase.
* |If Length increases by 2 and Precision increases by 1, then the Precision increase is applied.
* |If Length decreases by 2 and Precision increases by 1, then the Precision increase isn't applied.

* |If Length increases by 2 and Precision increases by 3, then the Precision increase isn't applied.

If a situation occurs where the Type, Length and/or Precision values for existing columns aren't updated, the
column must first be deleted from the FS-PRO Table definition and dropped from the database. The PBT
import can then be re-executed to re-import the revised column.

Integration Guide for Coverage-based Insurance Solutions
Setting Up Product Replication from FS-PM PUBLIC

49



8.3.2 Overriding the Fraction Decimal for Currency Scaling

The fractional decimal for a specified currency that is defined in the ISO 4217 standard may not be the
precision needed for currency scaling. An alternate precision can be defined within a CSV file.

Context

A Restriction

The currency scaling feature is available for use with coverage-based products only. It is not supported for
risk-based products.

The default location for the CurrencyDecimalPlaceDef _default.csvfileisin
the following FS-QUO CSI1_HOME sub-directory: <CSI_HOME>/as/custom/web/resource/
CurrencyDecimalPlaceDef_default.csv

When attempting to determine the precision, FS-QUO will initially attempt to lookup the currency fraction from
the CurrencyDecimalPlaceDef _default.csv file. If a currency isn't found in the CSV then the currency
fraction from the ISO 4217 standard will be returned and applied.

Procedure

1. Launch Internet Explorer and log in to the Design Time Administrative Console at the following location:
<pro_designtime_app_url>/csiroot/admin/.

The Design Time Administrative Console will open after a short delay.
Go to|r System » Edit File System 3.
From the Path dropdown list, select PA - Custom Web Root (Write).

Navigate to the resource folder.

Download the file.

SR T

Edit it to define the new fractional decimal value.

A fractional decimal needs to be defined for each currency.

~

Save your changes.
8. Upload the updated file.
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8.4 Manually Adding Precision Values for Currency Fields

For PBT Import to work with multi-currency, you must manually add Precision values for specific columns.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Add the following Precision values for the Product Modeler data definitions area:

* | SAP DD Manual Cost Posting Template » Column % DEBIT_AM 3
* | SAP DD Manual Cost Posting Template » Column » MACCCOSTS_AM 3
* |+ SAP DD Coverage » Column » BPML_AM 3

® Note

2 is the amount you must specify for Precision.
3. Build and sync the flowstore to update your database.

® Note

Sync flowstore will require attention from a database administrator since the precision will increase
without increasing the overall data length. Your database administrator must alter the column precision
and also perform some temporary data porting for any existing data due to the precision changes on
existing columns.

8.5 Importing Non-IFBC Tables

On the Non-IFBC Import tab, you import non-IFBC tables.

Context

- Tip

Initially, the window takes time to populate. Once populated, the table data appears. If you don't see the
table you want, you can also search for a table by table description. Italicized names are out-of-the-box
tables, and tables you imported are non-italicized.
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Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Choose | Tools ¥ Product Replication 3 from the menu bar.
The Product Replication window appears.

3. Select the Non-IFBC Import tab.

4. Select the templates you want to import by selecting the checkbox to the left of the Table Description
column.

There is no limit to how many tables you can import.

® Note

If you want to import any tables that aren't in the list contact SAP development.
5. Choose Import.

A Restriction

Don't delete any items from the system repository or issues can occur. SAP isn't responsible for items
you delete from the system repository.

The following list describes the non-IFBC columns:

Table Description Name of entity that you are importing from FS-PM.
Table Name Name of the table you are importing.
® Note

If you are importing tables that begin with the letter T (for example, TO06),
the import process takes time.

Last Importin FS-PRO Date and time when templates were last imported.

Status Status of the template (Success or Failed).

8.6 Importing CBO Tables

Use the CBO Import tab to import the tables.

Prerequisites

There is mandatory configuration that must be applied in FS-PRO before attempting a CBO Import. For more
information, see the following SAP Notes:
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* 2198767¢
* 2198768
* 2198761

Procedure

1. Create an extended global reference object in the Template Library inthe Product Modeler. This is

where the imported CBO tables are stored.

You can assign any name that you like to this extended global reference object. However, if you choose
a name other than the system default (SAP Extended Global Reference Object), you will need to

perform Step 2. If you use the system default name, you can skip to Step 3.

2. If you did not use the default name for the new object, then you must update the value of a configuration
variable in the Design Time Administrative Console so that the CBO import works correctly:

a.
b.

C.

e.

f.

S e

Log in to the Design Time Administrative Console.
Choose |+ System  Edit Configuration Settings 4 from the menu bar.

Navigate to [r Configuration » PC » Env » IFBC Replication Setting 4.
A table appears.
Find ExtendedGlobalRefOjbect in the Name column of the table.

The default column lists the system default name.

Enter the new name that you want to call the object in the Override column.

Save your changes.

Return to the Product Modeler.

Go to | Tools ¥ Product Replication 3.
Select the CBO Import tab.

Enter the name of the table you want to import.

If there is more than one table, separate the table names with a comma.

7. Choose Import.

Results

The CBO table is imported.

8.7

The Import Log tab on the Product Replication window helps you to understand the status of the template
import process. The tab displays all logs, grouped by import type: IFBC, PBT, NON-IFBC and CBO.

It tells you what was imported, how much time it took to import, and why it failed (if unsuccessful).

Viewing the Import Log
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¢ [INFO] gives you general status information on the import.
* [SEVERE]tells you why the import failed.

8.8 Using the PBT Schema Synchronization

The PBT Schema Synchronization performs an analysis of the differences between the remote system and
your SAP system. You perform either of the following functions:

¢ Simulation—to review database table differences before any changes or reconciliations are made.
* Synchronization—to perform a database synchronization immediately.
® Note

SAP recommends you perform a simulation before you synchronize your databases.

8.8.1 Performing Database Simulations

You can run a database simulation before synchronizing the schema.

Procedure

1. Launch Internet Explorer and log in to the Design Time Administrative Console at the following location:
<pro_designtime_app_url>/csiroot/admin/.

The Design Time Administrative Console will open after a short delay.

2. Gotol|p Product » PBT Schema Synchronization
A PBT Schema Synchronization dialog box appears with options to simulate or synchronize.

3. Choose Simulate.

Results

If there were no errors in the simulation, you receive the following message: No issues found in test
simulation. You may now perform the actual synchronization.

If there were errors in the simulation, you can review those errors and make any updates before running the
synchronization.
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8.8.2 Performing Database Synchronizations

Synchronizing the database performs an analysis of the differences between the remote system and your SAP
system.

Procedure

1. Launch Internet Explorer and log in to the Design Time Administrative Console at the following location:
<pro_designtime_app_url>/csiroot/admin/.

The Design Time Administrative Console will open after a short delay.

2. Goto|r Product » PBT Schema Synchronization .
A PTB Schema Synchronization dialog box appears with options to simulate or synchronize.

3. Choose Synchronize.

Results

If there were no errors in the synchronization process, you receive the following message: Successfully
synchronized schema. Please build metadata to complete the entire process.

If there were errors, you must fix the errors and repeat the synchronization process.

To build metadata, see Building All Objects of a Type.

8.9 Entity-based IFBC Import

An entity-based IFBC Import allows you to choose what portion of a product to process during IFBC Import,
instead of having to import the entire product every time.

To implement this type of import, you will need to create a new type of CSV file. The content of the CSV file
must have the format of: <ParentTemplateObject>,<VersionNo>,<EntityType>.

Next, you will need to create a folder in CSIHome to house the entity-based mapping CSV files:

Log on to the Administrative Console.

Gotoll System ¥ Edit File System 3.

From the Path dropdown list, select PA — Custom Integration Folder (Write).
Expand productengine/replication.

Add a new folder called ent i t ybased.

R N

Navigate to the entitybased folder and upload any entity-based mapping CSV files into here.
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8.9.1 Executing an Entity-based IFBC Import

Context

An entity-based IFBC Import allows you to choose what portion of a product to process during IFBC Import,
instead of having to import the entire product every time.

Procedure

1. Login to Product Modeler.
2. Navigate to || Tools » Product Replication » IFBC Import 1 tab.

3. Select a product to import.

Entity-based import only works for one product at a time.

4. Select | Import » Entity Based
5. Select a mapping file from the Mapping File dropdown.

6. Select one or more Contract to import and select Import.

A confirmation message is displayed.

7. Verify that the information is correct, and select OK.

Results

A new IFBC Import job will be kicked off to process this entity-based import. You can track the progress via the
Scheduled Activity Manager or by going to |j¢ Tools » Product Replication ¥ Import Log . tab.

8.10 IFBC Import of FS-PRO Product Data

In addition to the actual IFBC import, you must adapt the following Customizing settings after the IFBC import
has been executed:

* Product Module Group Customizing in FS-PM
* Assignment of Business Transactions
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8.10.1 IFBC Import

Depending on the operation mode you choose in FS-PRO, either the IFBC import is started automatically

or you must start the IFBC import manually. If you have to start the IFBC import manually, perform the
Customizing Activity Execute Import of FS-PRO Product Data in Customizing for Policy Management under
| In-Force Business Management # Basis  In-Force Business Configurator 3. For more information, see the
documentation of the Customizing activity.

8.10.2 Assigning Business Transactions

To execute business transactions for new IFBC product templates created during the import, you must assign
these business transactions to the corresponding IFBC product templates.

For more information, see the Assignment of Business Transactions topic from the SAP Policy Management at

Insurance Policy Management Overview product page on the help portal.
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9 Configuring a Product to Allow Change
Business Transactions

You can create a product that allows the creation of New Business and also allow Change Business
transactions.

This functionality is exposed in FS-IPW via a Fiori tile called Manage Issued Policies.

Change Business Process Flow

The following diagram indicates the process flow for a product that has been configured for the Change
Business workflow:

FS-QUO Change Business Process Flow

New Change Business Transaction Manage Existing Change Business Transactions

Manage Issued
Policies
{Fiori Tile)

My Work List
(Fiori Tile)

Search Policy / Policy Transaction

>
Result History Actions Enter Change
Business

My Work Items.
(NB & CB)

Information
(Date / Reason)
uw
Approved )
Pracess 2 options are created, the firstis ABDA Model to Manage Quote
the Original policy image and UI Model
the 2" is the working option transformation
o Change Policy

> Data
Product Screen

vidence Manage Execute
Process Evidence Calculation

Rules

Submission

A

Submit for
Underwriting

Violations?

Generate Quote Quote Validation

Letter Summary

Simulate

Error(s) ?
Underwriting

Premium
Calculation

Error(s) ?

Validate Change(s)
(Fs-PM Simulation) TS
ABDA Model

Transformation

Restrictions and Limitations

The Change Business workflow is available only for solutions that include an integration with FS-PM version
1909 and later.
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Support of change business is for coverage-based products only. This workflow is not available for risk-based

products.

The following FS-QUO features are not supported in the Change Business workflow:

¢ Qut of sequence changes (Undo/Redo)

¢ (Cash Before Cover (CBC)
* Multi-currency

* Counteroffers

Creating a Product

You can quickly create a product that employs a Change Business workflow by using the sample Auto product
(SAP S4 PR Motor Vehicle Insurance)templates. For guidance about creating a product, see Creating a
Product Using the Sample Auto Product Templates.

® Note

In order to enable the Change Business functionality for a product, you need to set the ChangeBusiness

attribute, under the | Extended Underwriting Application Configuration  Available Product 3 component.

Configuring RFCs

All of the RFC functions are located in |» SAP S4 Global Reference Object » Configuration » Integration » RFC

» Remote Function System 3.

Functionality

Business Function Name

RFC Name

Search based on policy

SEARCH_POLICY

/PMO/ABT_SVC_POL_FIND

Search based on account (policy holder
or representative)

SEARCH_ACCOUN_BANK

/PMO/ABB_BP_SEARCH_BANK_ES

SEARCH_ACCOUNT_CCARD_DETAILS

/PMO/
ABB_BP_SEARCH_CCARD_DD_ES

SEARCH_HELP

BAPI_HELPVALUES_GET

SEARCH_ADR

/PMO/ABB_BP_SEARCH_ADR_Q_ES

SEARCH_QUO_ADDRESSDATA

/PMO/ABB_QUO_ADDRESSDATA_GET

SEARCH_ADR_DETAILS

/PMO/
ABB_BP_SEARCH_ADR_Q_ES_2

SEARCH_ACCOUNT_ADR_DETAILS

/PMO/ABB_BP_SEARCH_ADR_DD_ES

Header details

READ_POLICY

/PMO/ABT_SVC_POL_READ

Transaction details

SEARCH_APPLICATION

/PMO/ABT_SVC_APPL_FIND
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Configuration for Business Transaction (BTX) Execution

Every product will have business transactions (BTXs) that are possible on a policy configured in IFBC. A similar
BTX configuration must be maintained for every product in FS-QUO.

1. Pushthe product to FS-PM.
2. Manually perform the BTX assignment in FS-PM's IFBC.
3. The same set of BTXs will need to be manually configured in the product in FS-QUO.

® Note

This process is not automated.

Business transactions are located in |[» SAP S4 PR Motor Vehicle Insurance » Configuration j» Integration
»BTX 1.

There are three components in FS-QUO for the BTX Framework:

Available BTXs This component is the FS-QUO-equivalent of the FS-PM assignment of business
transactions in IFBC.

® Note

In IFBC, BTXs are assigned at different levels (policy, contract, coverage, etc). In
FS-QUO, BTXs are all assigned at the product level.

BTX Configuration  This component allows users to specify the order of BTX execution, the operation that
can be performed (example: update, delete, create) on entities, specify the table and
the column set that are modifiable for the BTX

BTX Update This component allows users to specify the exclusion of columns in a BTX.

Excluded Columns  The excluded columns will not be sent to FS-PM during BTX execution.

For more information about working with the BTX Framework, see the Business Transaction (BTX) Framework
[page 64]

9.1 Understanding the Change Business Workflow

This topic describes the workflow of a product that has been designed to include change business
transactions. This functionality is exposed in FS-IPW via a Fiori tile called Manage Issued Policies.

® Note

Change Business functionality is demonstrated in products that were created using a non-hierarchical Ul
model. The SAP S4 PR Motor Vehicle Insurance templates are provided out of the box to help you
get started. For more information, see Creating a Product Using the Sample Auto Product Templates
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-> Remember

For Change Business functionality to be enabled in a product, you need to set the ChangeBusiness

attribute, under the |» Extended Underwriting Application Configuration » Available Product 3 component.

The Change Business workflow begins with the user searching for an policy that was issued in FS-PM, either via
the policy number or account information.

Search based on policy If the policy is found in the FS-PM system, the result will be displayed in the
user's worklist.

Search based on If the user searches for policies based on account information (the account

account (policy holder or must be a policy holder or a representative), all the policies belonging to the

representative) account will be retrieved and displayed in the worklist. A maximum of 100

results will be displayed on screen.

The user will select a policy from the worklist. Once the user selects the policy from the worklist, they then
navigate to the next screen where the header details are displayed for the policy (this is a static screen).

For the displayed policy, a grid is displayed with details of all the transactions that were applied on the policy. If
a Change Business transaction was created in FS-QUO, the submission number will be displayed in the grid.
® Note

If you have archived the submission numbers, it won't be displayed. The submission number must exist in
the database.

A Create Change Business button will be available on the transaction grid. The button will be visible on the Ul
only under the following circumstances:.

¢ The product has been configured in FS-QUO with Change Business enabled

* There are no other transaction on the policy with a status of in-process
Otherwise, the button will be hidden on the UL.

When the user selects the Create Change Business button, a new screen is displayed where the user can enter
the effective date of "change" to be applied and the reason for the change. The user then presses Next and
confirms the information to proceed.

® Note

Once the information on the General Info screen is confirmed, no change of Effective Date is possible.

Once confirmed, a new submission is created in FS-QUO with two quote options:

¢ Option 1isthe baseline option
* Option 2 is the option on which the user will be making changes

A Restriction

If an open submission exists for a change then no new change business can be started.

An external change application is created in FS-PM, the data of the policy as on that effective date, is
transformed and displayed in the FS-QUO Ul / eApp. The change application is locked in FS-PM.
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Next, the Ul needs to be transformed from FS-PM's ABDA data model to FS-QUOQO's Quote data model
via transformation rules. For example, the sample Auto product uses the SAP Transformation Rules
Component -> transformPol icyMode IDatatoUIModel rules.

To create a change external option in FS-PM, /PMO/ABT_SVC_CHGREQ_CRT RFM is called.

For the sample Auto product to demonstrate a consistent user experience between the New Business workflow
and the Change Business workflow, a "partial universal change" approach has been implemented in the
FS-QUO UL. This means that the eApp loaded for Change Business appears the same as New Business. Data is
retrieved from FS-PM and the ABDA data model is transformed to the Quote data model.

Every product will have business transactions (BTXs) that are possible on a policy configured in IFBC. In
FS-QUO for every product similar configuration has to be maintained for the product. For the sample Auto
product, three BTXs are configured out of the box.

For a universal change approach, the Ul for Change Business must be configured to ensure that for any
changes made on the Ul, there is a corresponding BTX that supports the change. If the Ul that is used for New
Business is implemented for Change Business and there are columns that are available (for example, insurable
object) for which the BTX is not configured, then the columns must be made read-only on the Ul. .

A new column TXN_TYPE_CD in the POLICY_TXN table has been introduced in the FS-QUO database. Itis
recommended that this flag be used to write rules for New Business vs Change Business.

When the user does not change the data on the eApp:

* If they press the Save icon, the premium will be recalculated and displayed

* If they press the Review button, an error or warning message will be displayed as no changes were made.
The framework in FS-QUO identifies the changes made on the quote with the baseline quote option. If
there are no differences found, then no BTXs will be derived and sent for simulation at review quote.

* If they press the Simulate Underwriting button, an underwriting decision will be given for the agent (the
same as in the New Business workflow)
® Note

Out of the box, the same underwriting rules are applicable for New Business and Change Business. You
can choose to write different underwriting rules for Change Business (using the TXN_TYPE_CD flag).

® Note

The only difference between the New Business and Change business underwriting workflow is that
counteroffer is disabled for Change Business.

* Ifthey upload an evidence, it will be uploaded at the policy level only. This restriction is for products created
with the Ul data model only.
When the user does change the data on the eApp:

¢ Ifthey press the Save icon, the premium will be calculated and displayed

¢ Ifthey press the Simulate Underwriting button, an underwriting decision will be given for the agent (the
same as in the New Business workflow)

® Note

Out of the box, the same underwriting rules are applicable for New Business and Change Business. You
can choose to write different underwriting rules for Change Business (using the TXN_TYPE_CD flag).
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® Note

The only difference between the New Business and Change business underwriting workflow is that
counteroffer is disabled for Change Business.

¢ Ifthey upload an evidence, it will be uploaded at the policy level only. This restriction is for products created
with the Ul data model only.

If they press the Review button after a change has been made (for example, adds a coverage or changes the
premium frequency), the following actions will occur:

—

FS-QUO will determine all the differences on the quotation compared to the baseline option (Option 1).

2. Once the deltais identified, FS-QUO calls an RFC (/PMO/ABT_SVC_CHGBTXPROPS_GET) and gets the
information from FS-PM to know what are the columns that are modifiable for the BTX.

3. FS-QUO also looks for the IFBC configuration to check the fields that are modifiable.
4. Once the delta is identified, the BTX to be applied is identified, columns are identified for the BTX that are

modifiable, and the actual BTX RFCs are called in FS-PM in "simulate mode". Only when the policy is being
issued are all of the BTXs applied in "update mode" in FS-PM.

Copy Quote

When an option is copied for a quote option with transaction type change business, the new quote optionis
created with the data from the source option (that is, the option being copied from). The newly "copied" quote
option will create a new external change option application in FS-PM during the copy process.

The principle is that all quote options for Change Business will have a corresponding external change option in
FS-PM. The rest of the copy functionality is the same as for New Business

Compare Quote

The functionality remains the same as with the New Business workflow.

Delete Quote

The functionality remains the same as with the New Business workflow.

Generate Quote Letter

The functionality remains the same as with the New Business workflow.
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Discard

The Discard button will be visible if there is an external change option open from FS-QUO when the user goes to
a transactions screen within the Manage Submission screen. Once the user selects the submission and presses
Discard, all quotes within the submission will be refused. Corresponding external change applications in FS-PM
will also be refused.

9.2 Business Transaction (BTX) Framework

Every product will have business transactions (BTXs) that are possible on a policy configured in IFBC.

For every product in FS-QUO, a similar configuration has to be maintained for the product:

1. Push the product to FS-PM.

2. Manually perform the BTX assignment in FS-PM's IFBC.

3. The same set of BTXs will need to be manually configured in the product in FS-QUO.
® Note

This process is not automated.

Sample business transactions can be viewed in | SAP S4 PR Motor Vehicle Insurance  Configuration
» Integration » BTX 1.

-> Remember

For Change Business functionality to be enabled in a product, you need to set the ChangeBusiness
attribute, under the |+ Extended Underwriting Application Configuration » Available Product 3 component.

There are three components in FS-QUO for the BTX Framework:

Available BTXs This component is the FS-QUO-equivalent of the FS-PM assignment of business
transactions in IFBC.

The technical names and descriptions of the BTXs need to be configured in FS-QUO.

® Note

In IFBC, BTXs are assigned at different levels (policy, contract, coverage, etc). In FS-
QUO, BTXs are all assigned at the product level. Also, if there is a change identified and
there is no respective BTX configured, then an error will be displayed.

BTX This component allows users to specify the order of BTX execution, the operation that can
Configuration  be performed on entities, specify the table and the column set that are modifiable for the
BTX.

Within the BTX Configuration for a product, the corresponding BTX operations need to be
configured (such as, update, delete, create). Within the BTX operations, the corresponding
BTX matching criteria and derived updates need to be configured.

Integration Guide for Coverage-based Insurance Solutions
64 PUBLIC Configuring a Product to Allow Change Business Transactions



BTX Update
Excluded
Columns

As an example, let's say that a BTX named Change Insured Object is configured within a
BTX Configuration. And let's say that updates are made to the Insured Object columns via
the eApp created with the sample Auto product: the Parking Area value is changed. Within
the BTX operations, an update is only possible on the POLPR_ABDASUBJCT table. Since the
Parking Area value is changeable on the Ul, this column has to be specified under the BTX
matching criteria.

When the user changes the Parking Area value at Runtime, the BTX framework identifies
the BTX operations (based on the BTX matching criteria) and the corresponding BTX to be
executed.

If you don't configure the Parking Area value in the BTX matching criteria and change the
Parking Area value, then no business transaction can be determined and an error will be
issued.

This component allows users to specify the exclusion of columns per entity in a BTX.

The excluded columns will not be sent to FS-PM during BTX execution. You can specify
whether inserting or updating records is possible. For example, if the update record for

the POLPR_ABDASUBJCT table is set to "0" and a user changes any of the insured object
columns at runtime, then the system won't allow the change and an error will result. This
configuration additionally allows users to define whether updates or inserts are possible on
entities.

Transactions supported by the Change Business framework, with out-of-the-box configuration via the

templates:

Change Payment Frequency Create and Process Coverage Edit Insured Object

Transactions supported by the Change Business framework, with the appropriate manual configuration by

customers:
Create and Process Contract Change Beneficiary Change Discount Protection
Create and Process Coverage Package  Edit Limit Change Exchange Rate Data
Change Main Due Date Change Adjustment End Adjustment
Exclude Coverage Exclude Sub coverage Change Adjustment
Change Policyholder Change Creditor Change Duration
Change Commission Participant Change Clause Change Benefit/Premium
Change Premium Payer Change Deductible Change CBC Amount Payer
Change Surcharge/Discount
Unsupported transactions:
Product Change Sales Product Change Execute Reversal
Reverse Manual Rating Execute Manual Rating Process Premium Waiver
Annul Premium Waiver Request CBC Amount Determine CBC Category
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9.3 MVA Namespace

Any column in FS-PM that uses the /MVA/ prefix must be mapped to their equivalent FS-PRO columns using
the Namespace Mapping component. Normally, there is no namespace required for FS-PRO tables, but if a
product in FS-PRO uses the FS-PM Auto Add On tables, an equivalent namespace configuration needs to be
maintained for the runtime integration.

This is required to Push / create an application during the Review Quote process.
The component can be found in |F SAP S4 Global Reference Object » Configuration ¥ Integration ¥
Namespace Mapping 3 and requires two attributes:.

QualifiedColumnName
Enter the column name from the FS-PM Auto Add On tables, if used.

NameSpace

For an auto product, the value for this attribute should be MVA.
Not all columns are mapped out-of-the-box, using the sample product.

Use of this component is required based on the product definition and entities being used.
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10 Using FS-PM for Quotation Calculation

FS-QUO uses FS-PM for premium calculation handling.

The premium calculations are performed within FS-PM itself. An application is created in FS-PM during the
review quote process.

This design offers the following advantages:

* Centralizes premium handling.
* Ensures consistency in premium output by avoiding any differences due to rounding errors.

* Improves efficiency by eliminating the need to maintain duplicate configurations like taxes, check-and-
derive rules, and so on, across components in different systems.

You must set a flag for each product to ensure FS-PM is used for premium calculation handling. Based
on this flag, a product service will be called. This product service is located in the Sample Insurance UWA

Product Template under |» Configuration » Product Services #» Service APl J. In the Values tab, the Service
Name is isNGTARelevant and returns true if the given product will use FS-PM to calculate quotes, or false
otherwise.

10.1 Configuring RFC Calls Using FS-PM for Quotation
Calculation

A set of RFCs are configured within FS-PRO using FS-PM for quotation calculation.
Several actions are performed on the FS-PM system via RFC call.

The RFC calls are mapped within the SAP Global Reference Object within FS-PRO under the following

location: [» Configuration ¥ Integration » RFC » Remote Function System . Within the Values tab, expand the
Application anchored row which contains the Business Function Name and the RFC Name.

The following apply:

CREATE_AND_RETRIEVE  Creates, calculates and retrieves the application within FS-PM.
UPDATE_AND_CALCULATE Updates, calculates and retrieves the application within FS-PM.
ISSUE_APPLICATION Issues the application within FS-PM.

REFUSE_APPLICATION For submissions with multiple options, if any one option is Issued then the
applications corresponding to other quote options within the submission will be
Refused within FS-PM.
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10.2 Understanding the Workflow Using FS-PM for Quotation
Calculation

The following diagram illustrates the workflow with associated RFC calls using FS-PM for quotation calculation:

General Information eApp eApp
Screen Screen Screen
| Acionon EAPP
No Yes - Manage Submission
Exists? ange
Create INPI INPIPMO/ABT_SVC_INPI_C Screen RFC Name
JIPMO/ABT_APIF_CREATE_ HANGE_CALC
RETRIEVE |
Review Quote INPI: Insurance Policy Issuance
Screen - (official term for New Business “request” from extemal system)
(Working)
Review Quote
: : Screen
Review Quote Disapproved Review Quote Review Quote (Issued, with Policy number)
Screen Screen > Screen
(Disapproved) (Approved) (Quoted)
Referred AFé‘TEﬁS?S'IsNPI
- Review Quote I
RsiecllING] Screen I—
IPMO/ABT_APIF_REFUSE_APPL =
(Referred) Gther options Reject INPI
l exist JPMO/ABT_APIF_REFUSE_APPL
Manual UW o T o .
decision needed o Underwriting o

Additional Notes

1. Once you create a quotation and select Review within the eApp, there are two possible options:

Quote Option  The quote option exists within FS-QUO. An UPDATE_AND_CALCULATE RFC request is
Exists made to FS-PM which modifies and recalculates your application and displays the results
on the UL

Quote Option  The quote option doesn't exist within FS-QUO. FS-QUO makes a
Does Not Exist CREATE_AND_RETRIEVE RFC request to FS-PM. An application is created in FS-PM and
the calculated results are displayed on the Ul.

2. Selecting Manage Submission returns you to the eApp where you can change any of your quote options. If
you select Review again, FS-QUO performs the same operations described in the previous point.

3. Selecting Submit for Underwriting submits your quote option for underwriting. There are three possible
results once submitted:

Quote Option is If FS-QUO disapproves the quote option, FS-QUO makes a REFUSE_APPLICATION
Disapproved RFC request to FS-PM which refuses the corresponding application that was
created for the quote option.

Quote Option is The quote option requires manual underwriting.
Referred

® Note

If an underwriter rejects a quote option, the corresponding application in FS-
PM is Refused. If a quote option is referred and needs a counteroffer, the
change is done on the existing application for the quote option.
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Quote Option is The quote option is approved.
Approved

4. Once a quote letter is generated, if you select Issue, FS-QUO makes an 1SSUE_APPLICATION RFC request
to FS-PM which releases the corresponding application for the quote option. Since only one quote option
can be issued within a submission, all other quote options within the same submission are refused within
FS-PM.

10.3 APIF Field Mapping Rule Configuration

Certain fields returned from FS-PM require rectification.

When you use FS-PM for quotation calculation, the APIF Field Mapping Rule configuration component exists to
be able to apply defined rules on configured fields to ensure data consistency.

The fields are mapped within the SAP Global Reference Object within FS-PRO under the following location:

|+ Configuration ¥ Integration » RFC » APIF Field Mapping Rule 3. Within the Values tab, the mapping is as
follows:

Table Name The table that holds the field requiring rectification.
Column Name The name of the field requiring rectification.

Rule Type The predefined rule, which is applied to the field.
Rule Types

Removal of Leading Zeros

The removal of leading zeros rule has a Rule Type value of [ RenovelLeadi ngZero] - Renobveleadi ngZero.
When this rule is applied to a given field, any leading zeros are removed. This rule helps to ensure consistency
in data representation for things like Ul rendering, and so on.

Example

For integer values like 50, 100, 200, FS-PM may return these values as 0050, 0100, 0200. After applying the
removal of leading zeros rule, these values then become 50, 100, 200 respectively.
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10.4 Flagging Products for Rating

You must set a flag in your product to enable quotation calculation by FS-PM. This a mandatory step for all
products in the integration.

Context

A Caution

You need to complete the quotation process for all in-flight (not yet issued) quotes before enabling the flag.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

Navigate to your product in the Product Studio
Navigate to [ Identification » SAP Product Id 4 in the Product Tree.
On the Values tab, enter a value of 1 for the NGTA Method attribute.

Save your changes.

o 0~ W N

Repeat this process for every product in your library.

10.5 Identifying Duplicate Fields

Duplicate fields may exist as a result of incorrect fields or tables used in configuration.

Since FS-PM is used for quotation calculation, data is retrieved from FS-PM for things such as premiums,
policy information, and so on. This data needs to be mapped back to the correct tables within FS-QUO. There
are instances where you may have data in the same fields within base tables and extension tables. Base table
names contain the string ABDA whereas extension table names contain the string ALDA or AMDA or APDA.

For example, the field INSAMOUNTABS_AM resides in the base table COV_ABDABNF as well as in the extension
table COV_ALDABNF. Data existing in this field for both tables is no longer supported. In this case, only the
INSAMOUNTABS_AM field within the base table COV_ABDABNF should be populated.

Since the location and number of these types of issues is hard to determine when using FS-PM for quotation
calculation, if any such duplication is found, an exception or error is displayed which identifies the problematic
field or table. Your database administrator should correct this duplication by removing the duplicate content
from the extension table and fixing any references from within the eApp or rule as noted in the error message.
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10.5.1 Suppressing Exceptions on Duplicate Fields

You can suppress exceptions generated as a result of duplicate fields.

Context

An Administrative Console setting is provided which allows you to control whether or not to display an error
message for any duplicate fields found at Runtime.

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<pro_runtime_app_url>/csiroot/admin/.
The Runtime Administrative Console will open after a short delay.

2. Choose | System »» Edit Configuration Settings 3 from the menu bar.
3. Naavigate to|» Configuration ¥ Application ¥ AuthoritySuite » Env » Application Environment 3.

4. Find the SuppressExceptionOnDuplicateFields row. The default value is set to No, which displays an error
message for any duplicate fields found at Runtime. Setting the Override field to Yes, does not display an
error message.

5. Reload the configuration settings as follows:

a. Choose |r System ¥ Reload Configuration Settings 3 from the menu bar.
b. Choose Reload All Config.
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11 Designing the Cash-Before-Cover (CBC)
Process

Cash-Before-Cover (CBC) for Life insurance contracts is a process mandating that a certain amount of a
premium must be paid by the Insured (or the CBC payers) so that the quotation can be issued to an In-Force
Policy.

In FS-PRO, each life insurance product can be designed to follow one of following CBC scenarios:

Cash After Underwriting The actual payment (or cash) can be requested only when underwriting is
completed.

Cash Before Underwriting Underwriting can be processed only when the CBC amount is received in full
from the customer.

Cash Parallel to Underwriting The process of underwriting and the payment can happen in parallel.

- Tip

As pertains to CBC, underwriting refers manual underwriting, not system underwriting.

A Restriction

CBC is only applicable to individual quotes, not master or group. CBC is also not supported for products
created using the sample Auto product (SAP S4 PR Motor Vehicle Insurance).

Enabling a CBC process requires the integration of the FS-QUO, FS-CD and FS-PM applications. The three
systems interact in the following way:

* A CBCamountis requested from FS-QUO.
* AnRFC call is made to FS-PM to post the CBC amount in FS-CD.
* FS-CD notifies FS-PM when a full payment is received.

A Restriction

Partial payments aren't supported for CBC; only full payment is supported.

If no payment is made, or if payment is late, FS-QUO is notified by FS-PM:
* FS-CD informs FS-PM that no payment has been received.
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Sample: Workflow for Cash Before Underwriting

The following diagrams demonstrate a possible Cash Before Underwriting workflow:
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Sample: Workflow for Cash Parallel to Underwriting

The following diagrams demonstrate a possible Cash Parallel to Underwriting workflow:
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Related Information

Using FS-PM for Quotation Calculation [page 67]
Flagging Products for Rating [page 70]
Using FS-PM for Quotation Calculation [page 67]
Flagging Products for Rating [page 70]
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11.1 RFC Configurations Used For CBC

A set of RFCs are configured within FS-PRO to implement a CBC process.
As part of the CBC configuration, several actions are performed on the FS-PM system via RFC call.

The RFC calls are mapped within the SAP Global Reference Object within FS-PRO under the following

location: |» Configuration ¥ Integration » RFC » Remote Function System 3. Within the Values tab, expand the
Application anchored row which contains the Business Function Name and the RFC Name. The following apply
to the CBC:

CBC_CATEGORY Determines the CBC category for the application in FS-PM.
CBC_REQUEST Requests the CBC amount for the application in FS-PM.

11.2 Configuring Communications for CBC

As part of configuring a CBC process for your FS-QUO, you need to configure communication between FS-QUO
and SAP S/4 HANA Insurance for Policy Management (FS-PM) using OData.

Procedure

1. Optional: If you don't want to use the default RFC destination name INSURANCE_QUOQ, start transaction
SPRO.
a. Navigate to activity |» SAP Insurance » Policy Management } Integration ¥ Process Primary Settings
for Interfaces to External Systems 3.
b. Change the logical destination name for the QU Quotations entry.
2. Start transaction SM59 (Configuration of RFC Connections).
a. Create anew HTTP Connections to External Server.
b. Go to the Technical Settings tab.
c. Enter the name of the destination in the RFC Destination field.

For example, INSURANCE_QUO.

Enter ODATA Servi ce Host inthe Host field.

Enter/ A2A/ csi root /i pw/ quo/ odat a. svc in the Path Prefix field.
Go to the Logon & Security tab.

Select Basis Authentication.

Sm v o o

Enter the user credentials in the User and Password fields.
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11.3 Defining Products for CBC

In order for a product to be included in a CBC process, the following conditions must exist:

* The product must use FS-PM for quotation calculation.
* The product must be configured with a specific CBC scenario.

To make a product NGTA-relevant, the NGTA Method attribute must be set with a value of 1. This flag must be
set for each individual product that will use a CBC process.

Next, you have to design a CBC process for a product. Each product can be part of a single CBC scenario;
individual products can't be designed to use multiple scenarios.
You design a product for the scenario by setting a flag. This flag is found directly under the root level of the
product tree in the [ Identification ¥ SAP Product Id 3 component. Within the Values tab, set a value for the
CBCFlowForUW attribute for the desired process:

* Toenable the Cash before Underwriting process, set the CBCFlowForUw attribute to 1.

* Toenablethe Cash parallel to Underwriting process, set the CBCFlowForUW attribute to 2.

* Toenablethe Cash after Underwriting process, set the CBCFlowForUW attribute to 3.

11.4 Making Contracts Relevant for CBC

To make a contract relevant to a CBC process, you need to set the CBC_CATEGORY attribute. The attribute has
two possible values:

¢ CBC Amount with Payment Obligation
¢ (CBC Amount without Payment Obligation

® Note

Regardless of the value assigned to this attribute in FS-PRO, a payment must be received in full for the
quotation to be issued as an In-Force policy.

This attribute is found directly under the root level of the product tree in the | Contracts » ¥ Configuration
Integration » IFBC Control Integration Services » IFBC Control Attributes 3 component.
When FS-PRO replicates a product from FS-PM, you need to ensure that the IFBC control attribute's value

(CBC_CATEGORY) for the contract is identical in FS-PM and FS-PRO. If this value isn't identical, you will need to
change the value manually in FS-PRO after replication for every CBC-relevant contract.

® Note

It's possible to override the assigned CBC_CATEGORY value in FS-PM and redetermine the CBC
category using custom logic in a Business Add-In (BADI). In such a situation, you need to extend the
isCBCrelevent product service with similar logic.
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12 Key Integration Configurations in FS-PRO

This section describes the key Design Time integration configurations needed to successfully integrate FS-PRO
with FS-PM.

12.1 Business Partners

SAP Business Partner for Financial Services (SAP GP-FS) manages business partner data (for example,
producer names and addresses). In the Product Modeler, you must configure the corresponding business
partner objects in your product. The provided templates include policyholder, agent, beneficiary, and premium
payer objects. The SAP Insurance Reference Data Model dictates where these business partner objects
can be assembled in your product.

If you are integrating with FS-QUO, an underwriter or producer can add a business partner to a policy. To
enable this function, a connection for FS-QUO and SAP GP-FS must be configured so that adding business
partner data can be added.

The proper JavaScript code must be included in the eApp fields so that the data can be transferred from
FS-QUO to SAP GP-FS.

Notes:

* Producer and account information fields appear in both the FS-QUO general information screens and the
eApplication. In the eApplication, the producer ID is automatically populated with the ID of the producer
selected in the screen. However, for accounts, you must select the same account in the eApplication as
you entered in the general information screens. FS-PM uses the account information in the eApplication. In
FS-PM, the producer is a commission contract partner, and the account is a policyholder.

* To search for business partners, FS-QUO uses the FS-PM remote function calls to SAP GP-FS.

12.2 bpLookup Stem

A stem is a short name that represents a Java class. These classes contain related functions that you can use in
rule expressions in the Product Modeler.

Context

For example, the com.camilion.as.stem.FSPMIntegrationBPLookupStemclass (bpLookup stem)
contains a getAddressListByPartnerld function. You can define a rule that calls this function to load
addresses with a specified partner ID for a coverage.
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Procedure

1. Define arule in Rule Painter.

2. Inthe Expression Editor, enter the name of the stem that contains the function that you want to use, or you
can click the Function Picker icon and populate the Stem List.
The stem is the first element (the rule object) in the expression.

3. Enter aperiod (.) following the stem name.
The Functions List dialog box opens and displays a list of functions for the specified stem.

4. Select the function that you want use.
The function signature is added to the expression.

Whenever a stem is specified, the ServiceCommand is passed to the rule. For the key MasterResultSet
and ResultSet, you must specify a reference to the POLICY_QUOTE result set.

5. Complete the rule expression as appropriate.

For example, Using the bpLookup stem.

12.3 Business Partner Address

Previously, logic was embedded within the javascript to return the business partner address based on the
selected record (partner ID). This logic was replaced with a stem function that accomplishes the same thing:

CALL getAddressListByPartnerld IN LIBRARY bpLookup WITH <partnerld[String]>,
<partnerTypeName[String]>, <role[String]>, <maxRow[int]>

Functions:

partnerld[String] Bank Account records should be returned for the specified business partner
record (partner ID).

partnerTypeName[String] Filter results based on the business partner type.

payMethod[String] Filter results based on the pay method (for example, Bank Collection).
role[String] Filter results based on the business partner role.
maxRow(int] Specifies the number of business partner bank account records that should be
returned.
® Note

The benefit of a stem is that it can be used to return multiple addresses (and list them in a dropdown list).
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12.3.1 Bank Detail

The getBankAccountlInfoByPartnerld function searches for and returns all configured bank accounts for
the specified Business Partner Partner 1ID.

Functions:

partnerld[String] Bank Account records should be returned for the specified business partner
record (partner ID).

partnerTypeName[String] Filter results based on the business partner type.

payMethod[String] Filter results based on the pay method (for example, Bank Collection).

role[String] Filter results based on the business partner role.

maxRow(int] Specifies the number of business partner bank account records that should be
returned.

12.3.2 Pay Card

The getBankAccountinfoByPartnerld IN LIBRARY bpLookup WITH <partnerld[String]>,
<partnerTypeName[String]>, <payMethod[String]>, <role[String]>, <maxRow[int]>.

Functions:

partnerld[String] Bank Account records should be returned for the specified business partner
record (partner ID).

partnerTypeName[String] Filter results based on the business partner type.

payMethod[String] Filter results based on the pay method (for example, Bank Collection).

role[String] Filter results based on the business partner role.

maxRow[int] Specifies the number of business partner bank account records that should be
returned.

For more information, see Coverage-based Development Guide.
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12.3.3 Configuring the Fields to Add an Insurable Object

Context

If the lateral object represents an insured object, you must configure the Extended Underwriting
Application Configuration object. You must also configure the associated eApp Screen with a
JavaScript function that calls a servlet to add an insured object.

Procedure

1

84

Open the insured object at the template level.

Example:<company> Insurance UWA Insured Object Template

® Note

If your questions are specific to your product, you can define them in the model view object in the
product instead of the template. For example, in the Sample Household Product, choose [ Sample
Household Product  Contracts  Sample Household Contract # Coverages # Sample Household
Coverage ¥ Insured Objects » Sample Home Contents Insured Object 4

Choose the Model View object.

Example (template level): [» <company> Insurance UWA Insured Object Template ¥ User Interface » SAP
Insured Object Model View J

Example (sample product): [ Sample Household Product  Contracts  Sample Household Contract
Coverages » Sample Household Coverage ¥ Insured Objects » Sample Home Contents Insured Object
» Sample Home Contents Insured Object » User Interface » Sample Household Insured Object Model
View J

In the Configuration folder, open the Config object, and modify the REFERENCE_PRODUCT as needed.
Choose the following component and define the questions in the main grid: [ Questions

» <insured_object_name> Questions 3.

Example (template level): | Questions » SAP Insured Object Questions 3

Example (sample product): [ Questions » SAP Household Insured Object Questions 3

Design how the questions appear on the screen, as follows:

a. Choose | Views ¥ <insured_object_name> Questions J.
Example (template level): [ Views » SAP Insured Object Views 3
Example (sample product): | Views » SAP Household Insured Object View J
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Open Questionnaire Painter.

Design how the questions appear on the screen.

Configure a Create Insurable Object button.

Select the button and expand the Event Handlers tab.

Enter cr eat el nsur abl eObj ect () inthe onclick field, and choose Apply.

6. Configure which fields to display in the create insurable object view, as follows:

a.

Open the following object: |+ Product Studio ¥ Product Repository ¥ <company_library>
Configuration Objects » Extended Underwriting Application Configuration 3

Choose the following component: |F Insurable Objects » Insurable Object Categories 3
Expand the Home row.

The Insurable Object Types component appears.

® Note

You can create rows for additional categories.

. Add rows for the insurable object types.

® Note

A Home Contents row is already configured in this component for the Home category.

Expand the row for the insurable object type that you want to configure fields for.
For example, expand the Home Contents row.

The Insurable Object Fields component appears.
Select the rows for the fields that you want to display in the Create Insurable Object view, and
modify the column values as needed.

® Note

If the field to display is a dropdown list, in the FieldComponentName, specify a value that matches
a component inthe Field Data folder.

7. Inthe eApplication where you want to show the insured object view, do the following:

a.

© a0 o

Open the appropriate eApp Screen.

Example: | Sample Home Contents Coverage j# User Interface ¥ Data Capture ¥ eApplication » eApp

Section » eApp Screen 3

Add a row for the Insured Object Screen, and edit the Screen Id.

In the Questionnaire Layout Painter, add the insured object view to the layout.
In the layout, select the <insured_object> Level Viewthatwas added.
Choose Custom Javascript from the right panel and paste the following code:

function createlnsurableObject(){
var url = "/csiroot/cservlet/ASIntegrationServiet?
event=CREATE&isSave=false&tbl=mo";
var features =
"toolbar=no, location=no,status=no,menubar=no,scrollbars=no, resizable=yes,wi
dth=890,height=680";
var insuObjWin = window.open(url, "targetWindow" ,features);
insuObjWin.focus();
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function updateValue(ids, values) {
for(var i=0; i<ids.length; i++)
{
var column_id = "table_name."+ids[i] ;
if(document.getElementByld(column_id)!=null)

{
document.getElementByld(column_id).value =
trim(values[i]);

}
}

8. Choose Apply.
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13 Enhancement Options

13.1 Areas to be Enhanced in Different Systems

You can enhance the current integration scenario between the systems FS-PRO, FS-QUO, and FS-PM in the
following areas:

® Userinterface (in each system)

* Process/coding (in each system)

* Database (in each system)

* Interfaces between the three systems FS-PRO, FS-QUO, and FS-PM

In the following graphic, you can see the possible enhancement options:

>

Customer

Entity:

Create entity
Entity:
Change entity
Field:

Create field

Rule:
Create rule

Rule:
Change rule
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13.2 Entities and Templates in FS-PRO

To enhance FS-PRO, FS-QUO, and FS-PM, you need to know where and how information is typically grouped
and stored. The grouping is realized through entities.

The integration scenario differentiates between the following entities:

Entities Used for the Sample Household Product

* Examples for these entities are part of the Sample Household Product thatis included in the shipment.
* You can use these examples and create your own products based on the FS-PRO templates provided.

* These examples should give guidance how typical product requirements and rating can be implemented
(for instance, the adding and removal of a clause in the Product Web Services (PWS) depending on
a condition can be learned from the Underinsurance Waiver Clause inthe Sample Household
Product).

® Note

Customer specific products will deviate from these examples.

Entities not used in the Sample Household Product such as Beneficiary,
Contract Bundle, Coverage Bundle

* These entities aren't part of the Sample Household Product since, from a business perspective, they
don't make sense for a simple household insurance product.

* However, these entities are provided in the shipment and ready for use, but you won't find examples of
these assembled in a sample product.

* Customers should be able to add these entities to their products easily if they add the appropriate product
definition.

® Note

Contact SAP development if you want to use an entity that isn't provided out-of-the-box.

13.3 List of Provided Entities

This topic lists the entities that are provided out-of-the-box.

In the following tables, you can find a list of used entities:
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Auto Entities

Technical Name

Title

/MVA/AMDABM Bonus-Malus
/MVA/AMDACLAIMSU Calculate Claim Surrender
/MVA/AMDACLPART Bonus-Malus - Claim Comparison
/MVA/AMDACQOV Auto Coverage
/MVA/AMDAEXEQMT Special Equipment
/MVA/AMDAPCMP Premium Comparison
/MVA/AMDAPOLPR Auto Contract

/MVA/AMDATR Region Class Type

Other Entities

Technical Name

Title

/PMO/ABDAAGENT Representative
/PMO/ABDABNF Benefit
/PMO/ABDABNFCRY Beneficiary
/PMO/ABDACBCPAYR CBC Amount Payer
/PMO/ABDACLAUSE Clause
/PM0O/ABDACOV Coverage
/PMO/ABDACOVCPCO Subcoverage (P and C)
/PMO/ABDACOVPAC Coverage Bundle
/PMO/ABDACRDITOR Creditor
/PMO/ABDADEDCTBL Deductible
/PMO/ABDADEP Dependency
/PMO/ABDADEPREL Dependency Assignment
/PMO/ABDADISTREL Distribution Plan Relationship
/PMO/ABDAEXREF External Reference
/PMO/ABDAEXTPCL Related Policy Claim
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Technical Name

Title

/PMO/ABDAEXTPOL

Related Policy

/PMO/ABDAINFRD

Dynamic Adjustment

/PMO/ABDALIMIT Limit

/PMO/ABDAPOLHLDR Policyholder

/PMO/ABDAPOLICY Policy

/PNMO/ABDAPOLPR Contract

/PMO/ABDAPPDPAC Contract Package
/PMO/ABDAPREM Premium

/PMO/ABDAPRMPAYR Premium Payer
/PMO/ABDAREPVAL Reported Value
/PMO/ABDARESDEPC Process-Dependent Condition
/PMO/ABDASBADR Insured Object Address Assignment

/PMO/ABDASBINC

Object Management

/PMO/ABDASUBJCT Insured Object
/PMO/ABDASUPDC Surcharge/Discount
/PMO/ALDAADDPRPY Special Deposit Payer
/PMO/ALDABNF Life Benefit
/PMO/ALDACOLLECT Collection
/PMO/ALDACOV Life Coverage

/PMO/ALDAINDINC

Individual Maximum Subsidized Premium

/PMO/ALDAPARTPAY Partial Payment
/PMO/ALDAPOLPR Contract
/PMO/ALDAPREM Premium
/PMO/ALDAPREMDEP Premium Deposit
/PMO/ALDAPROJEC Model Calculation
/PMO/ALDASSHEAD Shift Switch Header
/PMO/ALDASSWITCH Shift Switch
/PMO/ALDASUBSAG Subsidy Agency
/PMO/APDACOV P and C Coverage
/PMO/APDAPOLPR P and C Contract

/PMO/ABDASBINC

Insured Extension
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13.4 Supported Enhancement Scenarios

SAP supports the following enhancement scenarios:

* Customer wants to use entities provided out-of-the box
* Customer wants to add new fields to an entity

13.4.1 Using Entities Provided Out-of-the-Box

This topic describes how to enhance the integration scenario with entities provided out-of-the box.

Enhancement of processes in FS-PM (optional)

* InFS-PM, for more information about the enhancement options of processes, see the following references:
* Enhancement Guide for SAP Policy Management (BAdlIs)

* Enhancement Guide for SAP Policy Management (Enhancement of Standard Business Transactions)

¢ Customizing for Policy Management under |» In-Force Business Management j» Basis » Business
Processes » Business Add-Ins (BAdIs)
* InFS-PRO: New rules, etc.

Related Information

Adding New Fields in FS-PRO [page 92]

13.4.2 Adding New Fields to an Out-of-the-Box Entity

This topic applies if you are using FS-PRO as your product engine.

Enhancement of database (mandatory)

* You must enhance the database in FS-PM. For more information, see Enhancement Guide for SAP Policy
Management (DDIC Enhancements)

* You must enhance the database in FS-PRO.
* You must enhance the database in FS-QUO.
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For more information, contact your SAP implementation team or SAP Support.

Enhancement of user interface (optional, since in some cases no Ul is
needed)

* Enhancement of Ul in FS-PM. For more information, see Enhancement Guide for SAP Policy Management
(Changes to User Interface).

* Enhancement of Ul in FS-PRO
¢ Enhancement of Ul in FS-QUO

For more information, contact your SAP implementation team or SAP Support.

Enhancement of interfaces (optional, since in some cases interfaces are not
affected)

* FS-PM->FS-PRO:
¢ Call of Product Web Service (PWS)

* FS-PM -> Other systems, like FS-CM, FS-CD, FS-ICM, FS-RI etc. (see Enhancement Guide for SAP Policy
Management (Integration with Other Components)).

Enhancement of processes (optional)

* InFS-PM:
* Enhancement Guide for SAP Policy Management (BAdls)
* Enhancement Guide for SAP Policy Management (Enhancement of Standard Business Transactions)
¢ Customizing for Policy Management under ||» In-Force Business Management ¥ Basis » Business
Processes # Business Add-Ins (BAdIs)
* InFS-QUO: For more information, contact your SAP implementation team or SAP Support.

* FS-PRO: New rules, and so on.

13.4.3 Adding New Fields in FS-PRO

To add a new field to an entity, you must modify the product in the Product Modeler. For example, you might
want to record a new date value for policies. You must add the date field to a contract in the product.
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® Note

If you want to add the new field to FS-QUO, additional modification is required. For example, to get the date
value from a customer, you can add the field to the FS-QUO Ul so that producers or underwriters can enter
a value. For help with this FS-QUO modification, contact your SAP implementation team or SAP Support.

13.4.3.1 Adding the New Field to IFBC Column Details

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.
3. Open the entity object that you want to add a new field to.

4. Open the following object: |» <entity_or_object_name> » Configuration ¥ Integration » IFBC
<object_type_name> Integration Services » IFBC Column Details 3.
5. Add a row for the new field, and select it.

6. This definition specifies the new field as a characteristic (mark).

® Note

If the corresponding attribute doesn't exist in the PBT, you must add it to the appropriate channel
model. Otherwise, the IFBC import won't work properly. For more information about adding attributes
to the PBT, see the PBT documentation.

13.4.3.2 Updating the Policy Model Schema

Context

New fields should be added directly to the out-of-the-box policy model schema, based on the line of business.
For example, for PnC products you would add new columns to SAPInsurancePnCPol i cyModel Schema, for
LnA products you would add new columns to SAPInsuranceLnAPol icyMode lSchema and for auto products
you would add new columns to SAPInsuranceAutoMode ISchema.

Itis recommended that you extend a single schema for each line of business. For example, create and maintain
a single schema for all auto products.

Integration Guide for Coverage-based Insurance Solutions
Enhancement Options PUBLIC 93



->Tip

Avoid creating custom schemas, as you will need to manually update them when new entities are added to
default templates during FS-PRO software upgrades.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.

3. Navigate to the schema:

* |» <product_name> j» Configuration j Integration #» Product Web Services » XML Definitions
» SAPInsurancePnCPolicyModelSchema J
* |k <product_name> }» Configuration ¥ Integration » Product Web Services » XML Definitions
» SAPInsurancelL.nAPolicyModelSchema 3
* |p <product_name> » Configuration j» Integration » Product Web Services » XML Definitions
» SAPInsuranceAutoModelSchema
4. Add a new simple element for each new field.

5. Save your changes.

13.4.3.3 Updating the Data Model

You must add the new field to a table (data definition) in the data model.

If you want to add a field that is common to products in all lines of business, add the field to the appropriate
SAP Insurance Reference Data Model basis table in the following location: [ Product Studio » Product
Repository # <company_library> » Data Definitions # Extended 3.

If you want to add a field that is specific to personal and commercial (P&C) products, add the field
to the appropriate P&C extended table in the following location: |+ Product Studio » Product Repository
» <company_library> » Data Definitions j Extended » PnC 3.

If you want to add a field that is specific to auto products, add the field to the appropriate auto extended table
in the following location: |+ Product Studio ¥ Product Repository # <company_library> » Data Definitions
» Extended ¥ Auto 4.
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13.4.3.4 Building and Publishing the Product

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Open your product.
3. Build the metadata, questionnaire views, screens, and rules.

4. Publish your product and send the structure info to IFBC.

Results

The appropriate product templates are updated in IFBC. FS-PM can transfer corresponding policy and
endorsement information to FS-PRO for rating using product web service requests.
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14 Terms for Included Open Source Software

This SAP software contains also the third party open source software products listed below. Note that for these
third party products, the following special terms and conditions shall apply:

1

This software was developed using ANTLR.

2. gSOAP
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Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright (C) 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
SAP License Agreement for STLport SAP License Agreement for STLPort between SAP Aktiengesellschaft
Systems, Applications, Products in Data Processing Neurottstrasse 16 69190 Walldorf, Germany
(hereinafter: SAP) and you (hereinafter: Customer)
1. Subject Matter of the Agreement
1. SAP grants Customer a non-exclusive, non-transferrable, royalty-free license to use the
STLport.org C++ library (STLport) and its documentation without fee.
2. By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the
intellectual property laws, and to all of the terms and conditions of this Agreement.
3. The Customer may distribute binaries compiled with STLport (whether original or modified)
without any royalties or restrictions.
4. Customer shall maintain the following copyright and permissions notices on STLport sources and
its documentation unchanged: Copyright 2001 SAP AG
5. The Customer may distribute original or modified STLport sources, provided that:
* The conditions indicated in the above permissions notice are met;

* The following copyright notices are retained when present, and conditions provided in
accompanying permission notices are met:

Copyright 1994 Hewlett-Packard Company

Copyright 1996,97 Silicon Graphics Computer Systems Inc.
Copyright 1997 Moscow Center for SPARC Technology.
Copyright 1999,2000 Boris Fomitchev

Copyright 2001 SAP AG

Permission to use, copy, modify, distribute and sell this software and its documentation
for any purposes is hereby granted without fee, provided that the above copyright notice
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appear in all copies and that both that copyright notice and this permission notice appear in
supporting documentation. Hewlett-Packard Company makes no representations about the
suitability of this software for any purpose.

Itis provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation

for any purpose is hereby granted without fee, provided that the above copyright notice
appear in all copies and that both that copyright notice and this permission notice appear in
supporting documentation. Silicon Graphics makes no representations about the suitability of
this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation

for any purposes is hereby granted without fee, provided that the above copyright notice
appear in all copies and that both that copyright notice and this permission notice appear in
supporting documentation. Moscow Center for SPARC makes no representations about the
suitability of this software for any purpose. It is provided “as is” without express or implied
warranty.

Boris Fomitchev makes no representations about the suitability of this software for any
purpose. This material is provided "as is", with absolutely no warranty expressed or implied.

Any use is at your own risk. Permission to use or copy this software for any purpose is hereby
granted without fee, provided the above notices are retained on all copies.

Permission to modify the code and to distribute modified code is granted, provided the above
notices are retained, and a notice that the code was modified is included with the above
copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation

for any purposes is hereby granted without fee, provided that the above copyright notice
appear in all copies and that both that copyright notice and this permission notice appear

in supporting documentation. SAP makes no representations about the suitability of this
software for any purpose. It is provided with a limited warranty and liability as set forth in the
License Agreement distributed with this copy.

SAP offers this liability and warranty obligations only towards its customers and only referring
to its modifications.

2. Support and Maintenance SAP does not provide software maintenance for the STLport. Software
maintenance of the STLport therefore shall be not included. All other services shall be charged
according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject
to a separate contract.

3. Exclusion of warranty

As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot

guarantee that the STLport is error-free, without material defects or suitable for a specific application

under third-party rights. Technical data, sales brochures, advertising text and quality descriptions

produced by SAP do not indicate any assurance of particular attributes.

4. Limited Liability
1. Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized

operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to
gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
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2. lIrrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized
operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to
gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

3. Inthe case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage
caused by a defect or lost profit.

4. SAP and the Customer agree that the typical foreseeable extent of damage shall under no
circumstances exceed EUR 5,000.

5. SAP and the Customer agree that the typical foreseeable extent of damage shall under no
circumstances exceed EUR 5,000.

6. The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims
against employees or agents of SAP.

4. Adobe Document Services Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered
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trademarks or trademarks of Adobe Systems Incorporated in the United States and / or other countries.
For information on Third Party software delivered with Adobe document services and Adobe LiveCycle
Designer, see SAP Note 854621 Fr .
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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/contactsap

© 2025 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.


https://www.sap.com/about/legal/trademark.html

	Integration Guide for Coverage-based Insurance Solutions
	Content
	1 Introduction
	1.1 About this Document
	1.2 Audience
	1.3 Software Prerequisites
	1.4 Terminology
	1.5 Available Documentation
	1.6 Post-Installation Setup Checklist

	2 Creating the Users Needed for the Integration
	2.1 Creating a User in FS-PM for RFC Calls and Granting Authorizations
	2.2 Creating a User in FS-PRO

	3 Configuring RFC Destinations
	3.1 Configuring RFC Destinations in Products
	3.2 Configuring RFC Destinations in the Administrative Console
	3.3 Testing RFC Destinations

	4 Configuration Changes Needed for IFBC Push
	4.1 Verifying Custom Publishing Services are Selected
	4.2 Static Product Information for IFBC
	4.2.1 Types of Entities Provided
	4.2.2 IFBC Components in the Product Modeler
	4.2.3 Location of the IFBC Components

	4.3 Defining Static Product Information for IFBC Push
	4.3.1 Defining Product-level IFBC Components
	4.3.2 Defining Main Axis IFBC Components
	4.3.3 Defining Lateral IFBC Components
	4.3.4 Defining IFBC Integration Services

	4.4 Choosing Operation Mode for IFBC Import in FS-PRO
	4.5 Productive System Landscape

	5 Configuration Changes Needed for FS-PRO Runtime
	5.1 Customizations in SAP Policy Management
	5.1.1 Defining Product Module Groups for Runtime Adapter
	5.1.2 Assigning Implementation Classes to Product Engine Interfaces

	5.2 Technical Information for Integration
	5.3 Credential Handling from FS-PM to FS-PRO
	5.3.1 Authentication for Product Web Services
	5.3.2 Providing a WSDL for Product Web Services Endpoint at Customer Site
	5.3.3 Defining a Port for a Product Web Services Provider Endpoint


	6 Configuration Changes Needed in FS-QUO
	6.1 Configuring the Connection in FS-QUO
	6.2 Use of XSLT Transformation
	6.3 Using INPI Services
	6.3.1 Remote Functions Parameters Mapping Configuration
	6.3.1.1 Mapping INPI Input Parameters
	6.3.1.2 Mapping INPI Composite Keys
	6.3.1.3 Mapping INPI Transient Fields
	6.3.1.4 Mapping INPI Reserved Fields

	6.3.2 Mapping INPI Import Parameter
	6.3.3 Mapping INPI Namespaces
	6.3.4 Currency Scaling and INPI Services
	6.3.5 Using the Business Partner Search Adapter in FS-PM


	7 Configuration Changes Needed in SAP GP-FS
	7.1 Enabling the Business Partner Setting

	8 Setting Up Product Replication from FS-PM
	8.1 Mapping the IFBC Templates
	8.2 Importing IFBC Templates in FS-PRO
	8.2.1 Performing a Delta Check

	8.3 Importing PBT Tables
	8.3.1 Understanding Column Updates and the PBT Import
	8.3.2 Overriding the Fraction Decimal for Currency Scaling

	8.4 Manually Adding Precision Values for Currency Fields
	8.5 Importing Non-IFBC Tables
	8.6 Importing CBO Tables
	8.7 Viewing the Import Log
	8.8 Using the PBT Schema Synchronization
	8.8.1 Performing Database Simulations
	8.8.2 Performing Database Synchronizations

	8.9 Entity-based IFBC Import
	8.9.1 Executing an Entity-based IFBC Import

	8.10 IFBC Import of FS-PRO Product Data
	8.10.1 IFBC Import
	8.10.2 Assigning Business Transactions


	9 Configuring a Product to Allow Change Business Transactions
	9.1 Understanding the Change Business Workflow
	9.2 Business Transaction (BTX) Framework
	9.3 MVA Namespace

	10 Using FS-PM for Quotation Calculation
	10.1 Configuring RFC Calls Using FS-PM for Quotation Calculation
	10.2 Understanding the Workflow Using FS-PM for Quotation Calculation
	10.3 APIF Field Mapping Rule Configuration
	10.4 Flagging Products for Rating
	10.5 Identifying Duplicate Fields
	10.5.1 Suppressing Exceptions on Duplicate Fields


	11 Designing the Cash-Before-Cover (CBC) Process
	11.1 RFC Configurations Used For CBC
	11.2 Configuring Communications for CBC
	11.3 Defining Products for CBC
	11.4 Making Contracts Relevant for CBC

	12 Key Integration Configurations in FS-PRO
	12.1 Business Partners
	12.2 bpLookup Stem
	12.3 Business Partner Address
	12.3.1 Bank Detail
	12.3.2 Pay Card
	12.3.3 Configuring the Fields to Add an Insurable Object


	13 Enhancement Options
	13.1 Areas to be Enhanced in Different Systems
	13.2 Entities and Templates in FS-PRO
	13.3 List of Provided Entities
	13.4 Supported Enhancement Scenarios
	13.4.1 Using Entities Provided Out-of-the-Box
	13.4.2 Adding New Fields to an Out-of-the-Box Entity
	13.4.3 Adding New Fields in FS-PRO
	13.4.3.1 Adding the New Field to IFBC Column Details
	13.4.3.2 Updating the Policy Model Schema
	13.4.3.3 Updating the Data Model
	13.4.3.4 Building and Publishing the Product



	14 Terms for Included Open Source Software
	Important Disclaimers and Legal Information
	Copyright / Legal Notice


